Legal Notices

Disclaimer
Certain versions of software and/or documents (“Material”) accessible here may contain branding from Hewlett-Packard Company (now HP Inc.) and Hewlett Packard Enterprise Company. As of September 1, 2017, the Material is now offered by Micro Focus, a separately owned and operated company. Any reference to the HP and Hewlett Packard Enterprise/HPE marks is historical in nature, and the HP and Hewlett Packard Enterprise/HPE marks are the property of their respective owners.

Warranty
The only warranties for products and services of Micro Focus and its affiliates and licensors (“Micro Focus”) are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or editorial errors or omissions contained herein. The information contained herein is subject to change without notice.

Restricted Rights Legend
Contains Confidential Information. Except as specifically indicated otherwise, a valid license is required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 2001 - 2019 Micro Focus or one of its affiliates.
# Contents

Performance Center ........................................................................................................ 1

Welcome to Performance Center ....................................................................................... 7

**Part 1: Getting Started** .................................................................................................. 8
   Chapter 1: Before You Install ......................................................................................... 9
      Performance Center Components and Data Flow ....................................................... 10
         Architecture and Components .............................................................................. 10
         Applications ........................................................................................................... 11
         Communication Paths ............................................................................................. 12
         Coexistence of Installed Components .................................................................. 16
         Load Considerations ............................................................................................... 17
      System Component Considerations ......................................................................... 18
      Windows System Locale Considerations .................................................................. 21
      Required Services ...................................................................................................... 22
      Performance Center Prerequisite Software ............................................................ 22
      Pre-installation Considerations ................................................................................. 27
      Installation Package Details ..................................................................................... 29

**Part 2: Installation and Configuration** ......................................................................... 30
   Chapter 2: Installing Performance Center .................................................................... 31
      Installation Flow ......................................................................................................... 32
      Installing Application Lifecycle Management .......................................................... 33
      Installing and Configuring Performance Center Servers and Hosts ....................... 34
      Configuring Performance Center ............................................................................. 42
         Configuring Performance Center using the Configuration Wizard ....................... 42
         Adding the Performance Center Server to the System (Lab Management) .......... 42
         Logging on to Performance Center Administration ............................................... 43
         Adding or reconfiguring Performance Center Hosts .............................................. 44
            Adding hosts ......................................................................................................... 44
            Reconfiguring hosts after upgrading an existing LAB project .......................... 45
         Running a System Health Check ........................................................................... 45
         Setting the License Keys ......................................................................................... 45
            License Types ......................................................................................................... 46
            Adding Performance Center Licenses .................................................................. 46
      Installing Performance Center Silently .................................................................... 47
      Silent Installation of Prerequisite Software ............................................................. 47
      Setting Up the Silent Configuration ......................................................................... 49
Silent Installation of Performance Center Server and Performance Center Hosts ........................................ 51
Installing Standalone Components (Windows) ..................................................................................... 54
Available Standalone Components for Windows .................................................................................. 54
Installing Standalone Components ....................................................................................................... 55
Silent Installation of the Standalone Applications .................................................................................. 56
Installing Load Generator on Linux ........................................................................................................ 57
Deploying Dockerized Load Generators on Linux .................................................................................. 57
Prerequisites ........................................................................................................................................... 58
Run a dockerized load generator using the predefined image ................................................................. 58
Run a dockerized load generator using a custom image .......................................................................... 59
After running the load generator containers .......................................................................................... 60
Build a Custom Dockerfile Image ........................................................................................................... 60
Tips and guidelines ................................................................................................................................. 62
Deploying Dockerized Load Generators or Controllers on Windows ....................................................... 62
Prerequisites ........................................................................................................................................... 63
Run a dockerized load generator or Controller using the predefined image ......................................... 63
Run a dockerized load generator using a custom image ......................................................................... 64
Examples of customized content for Dockerfiles .................................................................................... 65
After Running the Load Generator Containers ...................................................................................... 66
Tips and Guidelines ................................................................................................................................. 66
Installing Additional Components ......................................................................................................... 67
Deploying Performance Center on AWS .................................................................................................. 68
Upgrading to the latest Performance Center patch .................................................................................. 69
Before installing a patch ............................................................................................................................ 70
Installing the patch in interactive mode .................................................................................................... 70
Installing the patch remotely from Performance Center Administration ................................................ 71
Installing the patch in silent mode ............................................................................................................. 71
Troubleshooting patch installation issues ............................................................................................... 71
Uninstalling Performance Center Server and Hosts ............................................................................... 72
Uninstalling Load Generator from Linux ................................................................................................. 73
Chapter 3: Post Installation Verification ................................................................................................ 74
Chapter 4: Performance Center Configuration Options .......................................................................... 77
Configuring IIS on Performance Center Machines to Use SSL .............................................................. 78
Before You Configure IIS ........................................................................................................................ 78
Configuring IIS to Work Over SSL ........................................................................................................... 78
Configuring Performance Center to Support SSL .................................................................................... 79
Configure Secure Communication with LoadRunner Components with TLS (SSL) ............................. 88
Working with the Performance Center Agent .......................................................................................... 88
Running the Performance Center Agent as a Process ............................................................................. 88
Running the Performance Center Agent as a Service ............................................................................. 88
Configuring the Agent on Load Generator Machines ............................................................................. 89
Mapping Network Drives when Running Agent as Service ..................................................................... 89
About Configuring Performance Center Agents Over the Firewall ........................................ 124
Configuring the Windows Performance Center Agent ......................................................... 124
Configuring and Running the Linux Performance Center Agent ........................................ 125
Agent Configuration Settings .............................................................................................. 126
Checking Connectivity ......................................................................................................... 128

Part 4: Troubleshooting ........................................................................................................ 131
Chapter 10: Troubleshooting Installation Issues ................................................................. 132
Unable to Launch any Program after Uninstalling Performance Center 11.5X .................... 133
Unable to Load Windows 8 Explorer Shell After Installing Performance Center Host ........ 133
Host Silent Installation Stops After Installing .NET Framework 4.6.2 ................................. 133
When Starting the Installation an Integration Error Occurs ............................................... 134
Error During Installation of Prerequisite WSE 2.0 SP3 or WSE 3.0 ................................. 135
Cannot Connect to Performance Center Server or Host .................................................. 135
Installation Hangs When Registering Modules .................................................................. 136
Performance Center Cannot be Added to ALM Due to Mismatch in Communication Security Passphrase .................................................................................................................... 136
Performance Center Server Cannot be Added to Lab Management: HostNotFound Error .... 137
Performance Center Server Cannot be Added to Lab Management: Change Machine Identity Fails ......................................................................................................................... 138
Working with Performance Center when Windows Firewall is Enabled ......................... 138
Uninstall of Performance Center Failed or Has Frozen ...................................................... 139
Cannot Log in to Performance Center via the Client Machine: JavaScript Error ............... 140
When Starting a Test Run, the Host is Added, but the Initializing Run Page Does Not Load 141
Cannot Run Performance Center Component Installation from Network Drive ............... 141
Unable to Install Performance Center Components from the Installation Directory .......... 142
Installing One of the Performance Center Components Cannot Use Default Port: Port Already in Use ........................................................................................................................................ 143
Unable to Use Non-Default Ports in Microsoft SQL .......................................................... 145
Test Fails to Start Error Message ....................................................................................... 146
Unable to View Topology Monitors Online ....................................................................... 146
Adding Server/Host to Lab Project: The Change Machine Identity Fails ......................... 147
Performance Center Server/Host Configuration Fails: The Process is in Use By Another Process ......................................................................................................................... 147
Performance Center Configuration Fails: Action Not Authorized Error ......................... 147
Performance Center Configuration Host Failed starting 'Performance Center Data Service' 148
When Adding Performance Center Server to ALM: Fails to Ping URL ......................... 148
Configure Performance Center to Work with Secure Cookies over a Secure Connection ..... 149
Unable to log on to the Database Server .......................................................................... 150
Incorrect time range displayed in online graph ............................................................... 150

Send Us Feedback ............................................................................................................... 151
Welcome to Performance Center

Welcome to the Micro Focus Performance Center Installation Guide.

Performance Center, a tool for managing performance test projects across different geographic locations, stresses your application to isolate and identify potential client, network, and server bottlenecks.

**Note:** Performance Center 12.61, 12.62, and 12.63 are patches that must be installed on top of Performance Center 12.60. For details on how to install a Performance Center patch, see "Upgrading to the latest Performance Center patch" on page 69.

Performance Center Help

When clicking context-sensitive help, Performance Center now links directly to the online Performance Center Help. We recommend you use the online help for the most up-to-date content.

If your organization has firewall restrictions that prevent you from using the online Help Center, you can download and deploy the Help Center on your local server. For details, see the Download Help Center page in the Performance Center Help.
Part 1: Getting Started
Chapter 1: Before You Install

This chapter provides information that will help you prepare for the Performance Center component installations.

This chapter includes:

- Performance Center Components and Data Flow .................................................. 10
- System Component Considerations ........................................................................ 18
- Windows System Locale Considerations ................................................................. 21
- Required Services ..................................................................................................... 22
- Performance Center Prerequisite Software .............................................................. 22
- Pre-installation Considerations ................................................................................ 27
Performance Center Components and Data Flow

This section describes the Performance Center system.

This section includes:

- "Architecture and Components" below
- "Applications " on the next page
- "Communication Paths" on page 12
- "Coexistence of Installed Components" on page 16
- "Load Considerations" on page 17

Architecture and Components

This section describes the architecture and components of Performance Center.

<table>
<thead>
<tr>
<th>Architecture/Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALM server</td>
<td>Provides a platform for core ALM functionality.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ALM Client</strong>. Users log in to ALM (user site), Site Administration (project and user management), or Lab Management from their client machine.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ALM Server Repository</strong>. Used for file storage.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ALM Database</strong>. Contains a schema per Performance Center project, as well as a separate schema for Lab Management and Site Administration.</td>
</tr>
<tr>
<td></td>
<td>For more details about ALM technology, see the Application Lifecycle Management Installation and Upgrade Guide.</td>
</tr>
<tr>
<td>Performance Center Server</td>
<td>Hosts the Performance Center Web pages that enable you to design performance tests, configure monitors, reserve testing resources, run and monitor test runs, and analyze test results.</td>
</tr>
<tr>
<td>Performance Center Administration</td>
<td>The center for managing lab resources (such as hosts and host pools), and for managing Performance Center assets (such as Performance Center licenses, projects, runs, timeslots, diagnostics, and usage reports).</td>
</tr>
<tr>
<td>Lab Management</td>
<td>Used for managing cloud settings when using cloud hosts in ALM, and automated maintenance of the system's key components to detect system failures.</td>
</tr>
</tbody>
</table>
### Architecture/Component

<table>
<thead>
<tr>
<th>Architecture/Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Center Hosts</td>
<td>Used to control performance tests, generate load, and analyze data. Performance Center hosts can be configured as Controllers, load generators, or data processors:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Controller.</strong> The manager of a performance test. The Controller receives scripts, runtime settings, and a list of load generators to use. The Controller issues instructions to the load generators including which scripts to run, how many Vusers to run per script, and scheduler settings. At the conclusion of the test run, the Controller collates the data. There is only one Controller per performance test.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Load Generator.</strong> Generate load by running virtual users (Vusers). The Controller dictates the manner in which they start and stop running. There can be any number of load generators for a given test.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Data Processor.</strong> Used for analyzing and publishing performance test results.</td>
</tr>
</tbody>
</table>

### Applications

The following standalone applications integrate with your Performance Center system:

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Virtual User Generator (VuGen)</strong></td>
<td>Generates Vusers by recording actions that typical end-users would perform on your application. VuGen records your actions into automated Vuser scripts which form the foundation of your performance tests.</td>
</tr>
<tr>
<td><strong>Analysis</strong></td>
<td>Provides graphs and reports with in-depth performance analysis information. Using these graphs and reports, you can pinpoint and identify the bottlenecks in your application and determine what changes need to be made to your system to improve its performance.</td>
</tr>
<tr>
<td><strong>Network Virtualization (NV)</strong></td>
<td>Installs Network Virtualization for the Performance Center machine.</td>
</tr>
<tr>
<td><strong>MI Listener</strong></td>
<td>Needed when running Vusers and monitoring applications over a firewall.</td>
</tr>
<tr>
<td><strong>Monitors Over Firewall Agent</strong></td>
<td>Used to monitor servers that are located over a firewall.</td>
</tr>
</tbody>
</table>
**Application** | **Description**
---|---
**PAL Data Set Creator** | This tool enables you to create production data sets. After creating the data sets, you can upload them from PAL and use them in your reports. You can create IIS W3C, Apache logs, Google Analytics, Webtrends, or RUM datasets. For details, see the PAL section in the Performance Center Help.

**TruClient Standalone** | Installs TruClient as a standalone application. Install this tool to record Web applications with TruClient technology. You save the recordings to a script that can be used in a performance test run.

Use the diagram and table in the "Communication Paths" and "Load Considerations" sections to determine which machines to allocate for which performance testing tasks.

For example, you can combine a number of components that have a light load on a single machine. For details on which components can be installed together, see "Coexistence of Installed Components" on page 16.

For information on installing the standalone applications, see "Installing Additional Components" on page 67.

**Communication Paths**

When installing Performance Center, it is important to consider the communication paths between the various components, and their resource demands.

When running a performance test, Performance Center components share information with ALM components via a distinct system of communication. Understanding which components communicate with one another and the method of communication is essential for configuring your system.
The following diagram illustrates the Performance Center communication paths in an advanced deployment:

Note:
- To view other deployment options that can be used for configuring Performance Center on-premises or on the cloud, see Performance Center Deployments in the Performance Center Help.
- If the installation cannot use a default port because it is already in use, you can change the port. For details, see "Installing One of the Performance Center Components Cannot Use Default Port: Port Already in Use" on page 143.
- You cannot have a firewall between the ALM server, Performance Center server, Performance Center hosts (used as Controllers), and MI Listener.
- Port 8182 from PC host to load generators is relevant when running NV emulation for viewing NV related graphs during online. If the port is closed, graphs are still available in...
the offline results analysis report.

- Port 54345 in the connection from PC Host to Diagnostics should be open from the PC Host to the Diagnostics Mediators. In a simple deployment, Diagnostic Commander and Mediator are the same server.
- Connections from APM tools to the AUT are not displayed in the diagram. Each AUT tool uses its own ports, which can be found in the corresponding product’s documentation.
- The external load balancer for Performance Center servers needs to be configured for sticky sessions based on the HTTP cookie `ASP.Net_SessionId`.

The following table displays the connection ports that must be opened for the incoming traffic on the various Performance Center components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALM server</td>
<td>HTTP for Jetty web server: 8080 **</td>
</tr>
<tr>
<td></td>
<td>HTTP for IIS web server: 80 **</td>
</tr>
<tr>
<td>Performance Center Server</td>
<td>HTTP (80) **</td>
</tr>
</tbody>
</table>

* ** indicates the port that should be open from the PC Host to the PC Host.
<table>
<thead>
<tr>
<th>Component</th>
<th>Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance Center Host</strong></td>
<td>HTTP (8731)</td>
</tr>
<tr>
<td></td>
<td>TCP (3333, 54245, 54345)</td>
</tr>
<tr>
<td></td>
<td>8182 for Performance Center hosts used as Load Generators to see online graphs for NV emulatio...</td>
</tr>
<tr>
<td></td>
<td>8731 for Performance Center server to communicate with the Load Testing Operator service that orchestrates the test.</td>
</tr>
<tr>
<td></td>
<td>8086 for Performance Center server/host to get online/offline analysis data. The port should be open for outgoing communication from the Performance Center server, and for incoming communication for the Performance Center host (for an internal database). For an external database, the port should be open for both incoming and outgoing communication from the Performance Center server and Performance Center host.</td>
</tr>
<tr>
<td></td>
<td>54345 for Load Generator agent service. Enables the Controller to connect to this host when it acts as a Load Generator.</td>
</tr>
<tr>
<td></td>
<td>54245 for Remote management agent service. Enables Performance Center server to perform lab maintenance operations on this host.</td>
</tr>
<tr>
<td></td>
<td>3333 for Data Collection Agent. Enables Performance Center to control the machine routing table during test execution, based on the definitions set in Target IPs in the project settings. It also enables getting resource utilization metrics while a test is running.</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>TCP 1433 (SQL), 1521 (Oracle) **</td>
</tr>
<tr>
<td><strong>Repository</strong></td>
<td>NetBIOS</td>
</tr>
<tr>
<td><strong>Diagnostics Server</strong></td>
<td>HTTP (2006) *</td>
</tr>
<tr>
<td></td>
<td>TCP (54345)</td>
</tr>
<tr>
<td><strong>Standalone Load Generator</strong></td>
<td>TCP (54245, 54345)</td>
</tr>
<tr>
<td></td>
<td>8182 to see online graphs for NV emulation information. If the port is closed, you can still see NV information in the offline results.</td>
</tr>
<tr>
<td><strong>Cloud-based Load Generator</strong></td>
<td>As defined in the Cloud Network Settings dialog box. For details, see Initial Cloud Settings in the Performance Center Help.</td>
</tr>
</tbody>
</table>
### Coexistence of Installed Components

The following table describes which components can coexist on the same machine.

<table>
<thead>
<tr>
<th>Component</th>
<th>Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI Listener</td>
<td>HTTP/TCP for load generator only: 443 **</td>
</tr>
<tr>
<td></td>
<td>TCP for Performance Center server and host (used as a Controller) only: 50500</td>
</tr>
<tr>
<td>Application under test</td>
<td>Any; HTTP (Random)</td>
</tr>
<tr>
<td>SiteScope - Topology</td>
<td>HTTP (8080) *</td>
</tr>
<tr>
<td>SiteScope - Monitor Profiles</td>
<td>HTTP (8888) *</td>
</tr>
</tbody>
</table>

* HTTPS is also supported on this component.

** Default values that can be changed during configuration

<table>
<thead>
<tr>
<th>Installed Application</th>
<th>Need to Install</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Analysis SA</td>
</tr>
<tr>
<td>Analysis SA</td>
<td>--</td>
</tr>
<tr>
<td>VuGen SA</td>
<td>Yes</td>
</tr>
<tr>
<td>Load Generator SA (LG SA)</td>
<td>No</td>
</tr>
<tr>
<td>Monitor Over Firewall (MOFW)</td>
<td>No</td>
</tr>
<tr>
<td>MI Listener</td>
<td>No</td>
</tr>
<tr>
<td>Diagnostics Mediator (DM)</td>
<td>No</td>
</tr>
<tr>
<td>LoadRunner (LR)</td>
<td>No</td>
</tr>
<tr>
<td>Performance Center Server (PCS)</td>
<td>No</td>
</tr>
<tr>
<td>Host</td>
<td>No</td>
</tr>
<tr>
<td>TruClient SA</td>
<td>Yes</td>
</tr>
</tbody>
</table>

SA = Standalone
Load Considerations

The following table provides some basic installation considerations for each Performance Center component:

<table>
<thead>
<tr>
<th>Machine</th>
<th>Quantity in the system</th>
<th>Load Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance Center Server</strong></td>
<td>At least two</td>
<td>Heavy load.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To balance the load, ALM has built in load balancing capabilities.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For additional load balancing support, you can install multiple Performance Center Servers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For details on load balancing, see Software Self-solve knowledge base article KM1052520.</td>
</tr>
<tr>
<td><strong>Performance Center Hosts</strong>:</td>
<td>At least one of each</td>
<td>Controller has heavy load.</td>
</tr>
<tr>
<td><strong>Controller, Load Generator, and Data Processor</strong></td>
<td></td>
<td>Load generator has medium load.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data processor has medium to high load.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>It is recommended to designate spare Controllers and load generators for fault-tolerance and high availability purposes.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
<td>- You can configure a host as a Controller + Load Generator, but this is not recommended because running Vusers consumes a lot of resources. Running Vusers on the Controller host is only appropriate for performance tests that have a very small number of Vusers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- You can configure a host as a Controller + Data Processor, but this is not recommended because data processing might consume high amounts of CPU and resources.</td>
</tr>
<tr>
<td><strong>MI Listener</strong></td>
<td>At least one, if you are monitoring over a firewall</td>
<td>Medium load.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Standalone installation is required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Cannot exist on a machine running IIS.</td>
</tr>
</tbody>
</table>
### Machine Quantity in the system Load Considerations

<table>
<thead>
<tr>
<th>Machine</th>
<th>Quantity in the system</th>
<th>Load Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Over Firewall machine</td>
<td>At least one, if you are monitoring over a firewall</td>
<td>Light load. Standalone installation is required.</td>
</tr>
<tr>
<td>SiteScope (optional)</td>
<td>One</td>
<td>Light load.</td>
</tr>
</tbody>
</table>

*Tip:* You should also consider the communication paths between the various components when installing Performance Center, and their resource demands. This information helps you configure your system to evenly distribute the load, and prevent overloading any particular resource. For details, see "Communication Paths" on page 12.

### System Component Considerations

The Performance Center system includes several components. This section provides pre-installation considerations for each of the components.

For system requirement details for each component, see the System Requirements Guide.
| Performance Center Server | • Uninstall any previous installations of Performance Center Server earlier than version 12.50 from your machine (Performance Center Server 12.50 and later support upgrade to 12.60 without having to uninstall the previous version).

**Note for Performance Center 11.52 or 11.52 Patch 1:** After uninstalling Performance Center 11.52 or 11.52 Patch 1, the Performance Center installer does not remove all of the related configuration settings. Prior to installing Performance Center 12.60, make sure to remove the configuration settings. For details, see Software Self-solve knowledge base article KM01174822.

• For best results, install the Performance Center Server on a clean machine with a new image.

• Performance Center Servers conduct Performance Center administration, test design, run operations, monitoring, and the user interface services for these operations. Because performance test run operations create heavy load on the Performance Center Server, we recommend installing at least two **Performance Center Servers** in your system. Using built-in load balancers, calls from ALM to Performance Center Servers are balanced among the Performance Center Servers in a round-robin fashion.

• Before you install the Performance Center Server, you must install Microsoft Internet Information Services (IIS 7.5/8.0/8.5/10).

  **Note:** For better security, we recommend you follow the Microsoft IIS security best practices to harden your IIS web server.

• During installation, some IIS features are updated on all Performance Center Servers using IIS.

  • The following features are enabled: Active Server Pages, ASP.NET 4.0 (IIS 7.5), ASP.NET 4.5 (IIS 8.0/8.5), ASP.NET 4.6 (IIS 10), Metabase, Static content, IIS 6.0 Management Compatibility, and Dynamic Compression.

  • The following feature is disabled: URL Authorization

• To install a Performance Center Server, you must have full local administrative rights on the designated machine.

• The Performance Center Server requires a specific Windows user to be defined on the machine. When using the default user or a custom local user, the user will be created on the machine and will be added to the Administrator group. Ensure that there is no security system in place that will prevent creating the user or that will remove the user from the Administrators group. For details on how to create this user, see "Installing and Configuring Performance Center Servers and Hosts" on page 34.

• If Performance Center is working with an Oracle database, ensure that the Oracle client installed on the Performance Center Server machine is at least the same version as on the Oracle server, and that connectivity is established.
with the Oracle Server. For details, see "Establishing Connectivity with Oracle" on page 91.

- You must install the 32-bit Oracle client installation, even though you are running the Performance Center Server on a 64-bit operating system.
- If you install the Oracle client after installing the Performance Center Server, you must restart the machine after installing the Oracle client.
- Oracle Monitoring: When defining Oracle monitors, install the Performance Center Server in a directory whose path does not include any of the following characters: `() : ; * / \ " ~ & ? { } $ % | < > + = ^ [ ]`. For example, on a 64-bit machine, do not install the Performance Center Server in the default installation directory `(C:\Program Files (x86)\...`, as this path includes illegal characters.
- Microsoft Windows Script Host should be version 5.6 or later. To verify the version number, navigate to the `<Windows installation directory>\Windows\system32` directory. Right-click `wscript.exe` and select `Properties`. In the `Version` tab, verify the file version number.

<table>
<thead>
<tr>
<th><strong>Performance Center Host</strong></th>
</tr>
</thead>
</table>
| - Uninstall any previous installations of Performance Center hosts earlier than version 12.55 from your machine (Performance Center hosts 12.55 and later support upgrade to 12.60 without having to uninstall the previous version).  
  **Performance Center 11.52 or 11.52 Patch 1**: After uninstalling Performance Center, the Performance Center installer does not remove all of the related configuration settings. Prior to installing Performance Center 12.60, make sure to remove the configuration settings. For details, see Software Self-solve knowledge base article KM01174822.  
  The Performance Center host installation was replaced by the LoadRunner installation. All references to the `<Performance Center host installation folder>` in the documentation should be read as the `<LoadRunner installation folder>`.  
  To install a Performance Center Host, you must have full local administrative rights on the designated machine.  
  The Performance Center Host requires a specific Windows user to be defined on the machine. This user is configured when adding the Host to Performance Center Administration. When using a default user or a custom local user, the user will be created on the machine and added to the Administrator group. Ensure that there is no security system in place that will prevent creating the user or that will remove the user from the Administrators group. For details on how to create this user, see "Installing and Configuring Performance Center Servers and Hosts" on page 34. |
<table>
<thead>
<tr>
<th>Standalone Load Generator (Windows)</th>
<th>You cannot install the Standalone Load Generator on the same machine as the Performance Center Server or Performance Center host.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone Load Generator (Linux)</td>
<td>You can install the Standalone Load Generator on Linux to run Vusers. The Linux Vusers interact with the Controller that is installed on a Windows machine. For details, see &quot;Installing Load Generator on Linux&quot; on page 57.</td>
</tr>
</tbody>
</table>
| MI Listener                        | ● The MI Listener must be installed on a standalone machine.  
● The MI Listener cannot be installed on a machine running IIS. |
| Monitor Over Firewall Machine      | The Monitor Over Firewall agent must be installed on a standalone machine. |
| ERP and CRM Mediator               | ● The ERP and CRM Mediator must be installed on a machine that resides in the same LAN as the monitored ERP/CRM server, preferably on a dedicated machine. It is not recommended to install the Mediator on a Siebel or Oracle server that is involved in the performance test.  

**Note:** When using SAP Diagnostics, ensure that a SAPGUI client is installed on the same machine as the ERP/CRM Mediator.  

● By default, the ERP/CRM Mediator agent is installed to run as a service. After installing the agent, verify that it is running as a service and not as a process. If it is running as a process, you must stop the process and run the agent as a service.  
● For information about configuring the ERP/CRM Mediator after installation and using the ERP and CRM Mediator to collect diagnostics data, see the Performance Center User Guide. |
| SiteScope Server                   | ● SiteScope is used for monitoring applications.  
● Refer to the SiteScope Deployment Guide for minimum requirements. |

### Windows System Locale Considerations

The Windows system locale (Culture and UI Culture) of the user running the Performance Center environment (IUSR_METRO unless changed) must match the localized version of your Performance Center software. When working with a non-localized version of Performance Center, the locale must be set to English (EN-xx). Since the Performance Center user is created and
configured when the machine is added to the LAB project, the system locale needs to be verified after completing all of the configuration steps.

For more details on setting the Windows system locale, see Software Self-solve knowledge base article KM01215254.

**Required Services**

Before you install Performance Center components, check that the services defined in the table below are running on each component machine and that the startup type for each service is defined as **Automatic**.

> Note: The default settings for running the services on the operating system may differ from one version to another. You should go through all of the services on each machine to ensure that the required services are running.

<table>
<thead>
<tr>
<th>Machine</th>
<th>Services</th>
</tr>
</thead>
</table>
| All Performance Center servers and hosts | • IPsec Policy Agent (for TCP/IP security)  
• Remote Procedure Call (RPC)  
• Windows Management Instrumentation (for Performance Center health check)  
• Windows Event Log (optional— used for debugging)  
• COM+ services (Event System and System application)  
• System Event Notification (for COM+) |
| Performance Center servers | • IIS Admin Service (Microsoft Service)  
• Workstation  
• TCP/IP NetBIOS Helper  
• World Wide Web Publishing Service (Microsoft Service)  
• Distributed Transaction Coordinator (MSDTC) |
| Performance Center hosts | • Remote Registry Service (requires for host monitor) |

**Performance Center Prerequisite Software**

Before you can install Performance Center, some prerequisite software must be installed on your machine. During installation, Performance Center checks whether the prerequisite software is installed on your machine. Performance Center enables you to automatically install missing software from the Performance Center installation package.
The following table provides a list of the prerequisite software and how Performance Center detects whether the software is installed.

### Note:
- If Visual C++ 2017 Redistributable is already installed Visual C++ 2015 Redistributable will not be installed. Visual C++ 2017 Redistributable should be compatible in most cases. For more details, see the Microsoft documentation.
- If installation of Visual C++ 2015 Redistributable Update 3 fails, install KB2999226 manually.

<table>
<thead>
<tr>
<th>Prerequisite Software</th>
<th>Machines</th>
<th>Means of detection</th>
</tr>
</thead>
<tbody>
<tr>
<td>.NET Framework 4.6.2</td>
<td>• All Performance Center server and host machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Standalone VuGen</td>
<td>Searches the registry key for the <code>Release</code> value. Its expected value should be greater than 378675:</td>
</tr>
<tr>
<td></td>
<td>• Standalone Load Generator</td>
<td>HKLM\SOFTWARE\Microsoft\NET Framework Setup\NDP\v4\Full</td>
</tr>
<tr>
<td></td>
<td>• Standalone Analysis</td>
<td><strong>Note</strong>: .NET Framework 4.6.2 replaces the .NET Framework 4.0 files. If there are any applications that are using the .NET Framework 4.0 files and are running during the installation of .NET Framework 4.6.2, you may need to restart your machine. If you are prompted to restart the machine, restart it before continuing the installation.</td>
</tr>
<tr>
<td>Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)</td>
<td>• All Performance Center server and host machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Standalone VuGen</td>
<td>HKLM\Software\Microsoft\Data Access</td>
</tr>
<tr>
<td></td>
<td>• Standalone Analysis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Standalone Load Generator</td>
<td></td>
</tr>
</tbody>
</table>

Performance Center (12.60-12.63)
<table>
<thead>
<tr>
<th>Prerequisite Software</th>
<th>Machines</th>
<th>Means of detection</th>
</tr>
</thead>
</table>
| Microsoft Core XML Services (MSXML) 6.0      | • All Performance Center server and host machines  
• Standalone VuGen  
• Standalone Analysis  
• Standalone Load Generator | Queries the existence and version of:  
%systemroot%\system32\msxml6.dll                                                     |
<table>
<thead>
<tr>
<th>Prerequisite Software</th>
<th>Machines</th>
<th>Means of detection</th>
</tr>
</thead>
</table>
| Microsoft Visual C++ | **All Performance Center server and host machines**<br>**Standalone VuGen**<br>**Standalone Analysis**<br>**Standalone Load Generator** | Queries the MSI manager for the GUID: `{65E5BD06-6392-3027-8C26-853107D3CF1A}`<br>**In addition, the following Windows updates need to be manually installed:**<br>**Windows 7 or Windows 2008 R2:** Required Updates:<br>• SP1<br>• Update for Universal C Runtime in Windows (Also known as UCRT or KB2999226. See [https://support.microsoft.com/en-us/2999226](https://support.microsoft.com/en-us/2999226).)**Windows Server 2012:** Required Updates:<br>• Update for Universal C Runtime in Windows (Also known as UCRT or KB2999226. See [https://support.microsoft.com/en-us/2999226](https://support.microsoft.com/en-us/2999226).)**Windows 8.1 or Windows Server 2012 R2:** Required Updates:<br>• March 2014 servicing stack update for Windows 8.1 and Windows Server 2012 R2 (See: [https://support.microsoft.com/en-us/2919442](https://support.microsoft.com/en-us/2919442). Includes the KB2919442 update.)<br>• Windows RT 8.1, Windows 8.1, and Windows Server 2012 R2 update: April 2014 (See [https://support.microsoft.com/en-us/2919355](https://support.microsoft.com/en-us/2919355). Includes the following updates: KB2932046, KB2937592, KB2938439, KB2934018, KB2959977, KB2919355)<br>• Update for Universal C Runtime in Windows (Also known as UCRT or...
### Prerequisite Software

<table>
<thead>
<tr>
<th>Software</th>
<th>Machines</th>
<th>Means of detection</th>
</tr>
</thead>
</table>
| **Microsoft Visual C++ Redistributable for Visual Studio 2015 x64** | • All Performance Center server and host machines  
• Standalone VuGen  
• Standalone Analysis  
• **Windows 10**: No updates required |
| **Microsoft Windows Installer 3.1**         | • All Performance Center server and host machines  
• Standalone VuGen  
• Standalone Analysis | Queries the MSI manager for the GUID:  
{36F68A90-239C-34DF-B58C-64B30153CE35} |
| **Internet Information Services (IIS)**     | Performance Center server         | Looks for one of the following:  
• Registration of the WindowsInstaller. Installer.com object version 3 or later  
• MSI.dll version 3 or later in the %systemroot% |
| **Strawberry Pearl 5.10.1**                 | • Standalone VuGen                | Queries the MSI manager for the GUID:  
{C977182F-221A-337A-8681-963808E0023A} |
<table>
<thead>
<tr>
<th>Prerequisite Software</th>
<th>Machines</th>
<th>Means of detection</th>
</tr>
</thead>
</table>
| Windows Imaging Component (WIC) | • All Performance Center server and host machines  
• Standalone VuGen  
• Standalone Analysis  
• Standalone Load Generator | Queries the version of:  
%systemroot%\system32\WindowsCodecs.dll |

**Pre-installation Considerations**

This section includes pre-installation considerations for all Performance Center components.

- To install and configure a Performance Center server or Performance Center host, you must have full local administrative rights on the designated machine.
- The Performance Center server and the Performance Center host cannot be installed on the same machine.
- Before you begin installing, you should decide which machine is to be used for what purpose. Consider the expected load on each machine when determining which components to install on which machines. For details, see "Coexistence of Installed Components" on page 16 and "Load Considerations" on page 17.
- We strongly recommend that you install Performance Center hosts on dedicated machines that do not contain, or provide access to sensitive information; and that you do a thorough security review of the network topology and access levels in your testing environment.
- To install Performance Center, you must first disable User Access Control (UAC). For details on how to disable UAC, see: [http://gallery.technet.microsoft.com/Registry-Key-to-Disable-UAC-45d0df25](http://gallery.technet.microsoft.com/Registry-Key-to-Disable-UAC-45d0df25).
- Performance Center server and host components are not FIPS complaint and cannot operate on a FIPS enabled Windows machine without additional configuration. For details on how to work with Performance Center on a FIPS enabled Windows machine, see [Software Self-solve knowledge base article KM01420828](https://softwaregrp.com/knowledgebase/CMS/ArticleDetails/79).
- If the Performance Center installation directory is located on a network drive, it is recommended to map the network drive before you run the installation.
- To enable running the installation from a network location, make sure that the network location path is added to the Trusted Sites of the machine on which you are running the installation.
• Ensure that the server time on the ALM server and Performance Center component machines is synchronized.

• If you are installing a Performance Center server or Performance Center host using a Remote Desktop connection (RDP), you must connect using the Console session.

• Performance Center is certified to work with VMWare ESX/ESXi 5.0 and higher. Due to the rapidly evolving architectures provided by Virtualization vendors, as long as the 3rd party vendor guarantees full compatibility of the virtualized environment to the Performance Center approved system requirements for physical hardware, then Performance Center will function as designed.

• If you are working with an Oracle database, ensure that the Oracle client is installed on the Performance Center server (with Administrator installation type), and that connectivity has been established with the Oracle server. Ensure that the tnsnames.ora file contains the same TNS entry for the source and target database server.

Note: You must install the 32-bit Oracle client installation, even though you are running the Performance Center server on a 64-bit operating system.

• For installation of standalone applications, you must manually install the prerequisite software. For the list of required prerequisites, see "Performance Center Prerequisite Software" on page 22. For details on installing the prerequisites in silent mode, see "Installing Performance Center Silently" on page 47.

• You cannot install Performance Center components on machines with existing LoadRunner installations. Before installing Performance Center, ensure that you have removed all versions of LoadRunner from the machine.

• Ensure that the operating system and the database are both configured for the same language. If not, some texts displayed in Performance Center will be corrupted. For example, if you are working with German, ensure that you are working on a German operating system, and that the database is configured for German.

• When ALM is configured to use SSL for DB connectivity, the Performance Center server will also connect to the DB using SSL. Verify that the CA that signed the certificate used by the DB server is trusted by the Performance Center server. The CA should be defined in the Windows certificate store on the machine level under "Trusted Root Certification Authorities" (certmgr.msc).

• When ALM is configured with SSL, the Performance Center user (by default, the local user IUSR_Metro) on the Performance Center servers and hosts needs to establish trust for all of the certificates required to secure the ALM URL. This must be done prior to adding the machines to Performance Center Administration as Performance Center servers or PC hosts:
  a. From the Performance Center servers or hosts, type `mmc` in the command window to open the Microsoft Management Console.
  b. In the Microsoft Management Console, select File > Add Remove snap-in.
c. Add the **Certificates** option to the Console Root and click **OK**. Select **Computer account** and click **OK**. Click **Finish**.

d. Under **Certificates** (Local Computer), import all the certificates related to securing the ALM URL to "Trusted Root Certification Authorities" and "Intermediate Certification Authorities".

### Installation Package Details

You can find information and components for the installation as follows:

<table>
<thead>
<tr>
<th>System requirements and supported versions</th>
<th><strong>System Requirements</strong> (previously named Product Availability Matrix or PAM)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported integrations</td>
<td><strong>Integrations Catalog</strong></td>
</tr>
<tr>
<td>Standalone installations (for example, for the load generator)</td>
<td>Found in the installation package's <strong>Standalone Applications</strong> folder. For details, see &quot;Installing Standalone Components&quot; on page 55.</td>
</tr>
<tr>
<td>Additional components (such as the Citrix Agent and so on)</td>
<td>Found in the installation package's <strong>Additional Components</strong> folder. For details, see &quot;Installing Additional Components&quot; on page 67.</td>
</tr>
<tr>
<td>Installation upgrades</td>
<td>For details on installing patches on top of Performance Center, see &quot;Upgrading to the latest Performance Center patch&quot; on page 69.</td>
</tr>
</tbody>
</table>
Part 2: Installation and Configuration
Chapter 2: Installing Performance Center

This chapter describes how to install Performance Center.

Note: Performance Center 12.61, 12.62, and 12.63 are patches that must be installed on top of Performance Center 12.60. For details on how to install a Performance Center patch, see "Upgrading to the latest Performance Center patch" on page 69.

This chapter includes:

- Installation Flow .......................................................... 32
- Installing Application Lifecycle Management ............................................. 33
- Installing and Configuring Performance Center Servers and Hosts ..................... 34
- Configuring Performance Center ......................................................... 42
- Installing Performance Center Silently .................................................... 47
- Installing Standalone Components (Windows) ............................................. 54
- Installing Load Generator on Linux ......................................................... 57
- Deploying Dockerized Load Generators on Linux .......................................... 57
- Deploying Dockerized Load Generators or Controllers on Windows ....................... 62
- Installing Additional Components ......................................................... 67
- Deploying Performance Center on AWS ................................................... 68
- Upgrading to the latest Performance Center patch ......................................... 69
- Uninstalling Performance Center Server and Hosts ....................................... 72
- Uninstalling Load Generator from Linux .................................................. 73
## Installation Flow

This section describes the steps required to install Performance Center.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Review pre-installation considerations</strong></td>
<td>Before beginning the actual installation procedure, check that you meet the prerequisite criteria for working with Performance Center. For details, see &quot;Before You Install&quot; on page 9.</td>
</tr>
</tbody>
</table>
| **Uninstall Performance Center** | Uninstall any previous installations of Performance Center Server if earlier than 12.50, and Performance Center hosts if earlier than 12.55 from the machine.  
**Note:** For Performance Center Server 12.50 and later and Performance Center hosts 12.55 and later, you can upgrade to 12.60 without having to uninstall the previous version. |
| **Install ALM** | Install the ALM server. For details, see "Installing Application Lifecycle Management" on the next page. |
| **Install and configure Performance Center servers and hosts** | 1. Install and configure Performance Center servers and hosts. For details, see "Installing and Configuring Performance Center Servers and Hosts" on page 34.  
2. Configure Performance Center in Performance Center Administration. For details, see "Configuring Performance Center" on page 42. |
Install standalone components

- Install standalone applications that provide advanced features for working with Performance Center. For details, see "Installing Standalone Components (Windows)" on page 54.
- To install a load generator on Linux, see "Installing Load Generator on Linux" on page 57.
- To install the load generator through a Docker container, see "Deploying Dockerized Load Generators on Linux" on page 57 and "Deploying Dockerized Load Generators or Controllers on Windows" on page 62.

Perform additional tuning and configuration

- Perform additional tuning and configuration settings to get the most out of Performance Center. For details, see "Performance Center Configuration Options" on page 77.
- You can set Performance Center to run Vusers and monitor servers over a firewall. For details, see "Working with Firewalls" on page 99.

Upgrade projects

Upgrade your existing projects to the current version of Performance Center. For details, see the Application Lifecycle Management Installation and Upgrade Guide.

Verify Installation

- Perform a post-installation verification. For details, see "Post Installation Verification" on page 74.
- For installation troubleshooting details, see "Troubleshooting" on page 131.

Installing Application Lifecycle Management

As a prerequisite to installing Performance Center components, you must install Application Lifecycle Management.

Note: Each Performance Center version is certified with a specific ALM version. Ensure you are installing Performance Center on a corresponding version of ALM. Corresponding...
versions are published on the Micro Focus download site. For details, contact MySupport.

To install Application Lifecycle Management:

1. Install the appropriate version of ALM for your system. For details, see the Application Lifecycle Management Installation and Upgrade Guide.

   Ensure that ALM is installed on a certified operating system. Consult the ALM System Configurations section of ALM System Requirements for a full list of recommended and supported operating systems for ALM.

2. Set up the ALM client machine with the correct browser configuration. For details, refer to the Application Lifecycle Management Installation and Upgrade Guide.

Installing and Configuring Performance Center Servers and Hosts

This section describes how to install and configure Performance Center servers and hosts.

Note:

- Before beginning the actual installation procedure, review the Performance Center installation flow. For details, see "Installation Flow" on page 32
- The Performance Center host installation was replaced by the LoadRunner installation. All references to the `<Performance Center host installation folder>` in the documentation should be read as the `<LoadRunner installation folder>`.
- If you are upgrading or migrating from an earlier version of Performance Center, follow the instructions in "Upgrading Previously Created Projects" on page 98.
- Performance Center 12.60 must be installed before you can install Performance Center 12.61, 12.62, or 12.63.

To install a Performance Center server or host:

1. **Launch the Performance Center installer.**
   
   Download the installer package, and run setup.exe.

2. **Select an installation option.**
   
   The setup program starts and displays the installation menu page.

   Select **Performance Center Server** or **Performance Center Host**.

   ![Note: If a particular host machine is to be used as a load generator only, we recommend that you install the Standalone Load Generator because the installation](image)
requires less disk space, and it is less time-consuming to move the load generator's setup files (compared to the Performance Center Host). For details on installing the Standalone Load Generator, see "Installing Standalone Components (Windows)" on page 54. To install a load generator on Linux, see "Installing Load Generator on Linux" on page 57.

3. **If necessary, install prerequisite software.**

Some prerequisite software must be installed on the machine before installing the Performance Center component. If any of the prerequisite software is not already installed on the machine, the prerequisite software dialog box opens.

Click **OK** and follow the on-screen instructions to install the prerequisite software before continuing with the Performance Center component installation. You cannot continue with the Performance Center component installation unless all the prerequisite software is installed.

For a full list of prerequisite software, see "Performance Center Prerequisite Software" on page 22.

**Note:**

- If you are prompted to restart the machine after installing the prerequisite software, you must do so before continuing with the installation. After rebooting the machine, run `setup.exe` again to continue with the installation. If the installation continues from where it left off before rebooting, we recommend starting the setup again—the installer will detect the installed prerequisites and continue with the installation.

- When installing a Performance Center server, if Microsoft Internet Information Services (IIS) 7.5/8.0/8.5/10 is listed on this page, it is required that you close the installation, install IIS, and restart the installation.

4. **If an earlier version of Performance Center is installed on your machine.**

A dialog box opens indicating that you must first manually uninstall the previous version before installing this version. For more details on how to uninstall Performance Center, see "Uninstalling Performance Center Server and Hosts" on page 72.

**Note:** If you previously installed:

- **Performance Center Server 12.50 and later and Performance Center hosts 12.55 and later:** The installation process detects the older version, and gives you the option to upgrade to 12.60 without the need to uninstall the previous version.
Performance Center 11.52 or 11.52 Patch 1: After uninstalling Performance Center, the Performance Center installer does not remove all of the related configuration settings. Prior to installing Performance Center 12.60, make sure to remove the configuration settings. For details, see Software Self-solve knowledge base article KM01174822.

Performance Center 11.5x: After uninstalling Performance Center 11.5x, there is a possibility that you will not be able to launch any program from your machine. This problem can occur on a Performance Center server or host. For more details on fixing this problem, see Software Self-solve knowledge base article KM01178049.

Network Virtualization: Make sure that Network Virtualization was uninstalled. If not, then uninstall it manually.

5. Start the installation.
   For Performance Center Server:
   The Performance Center Setup Wizard opens, displaying the Welcome page. Click Next.

   For Performance Center Host:
   The LoadRunner Setup Wizard opens, displaying the Welcome page. Select Performance Center Host, and click Next.

6. Review the License agreement.
   To accept the terms of the license agreement, select I accept the terms in the license agreement.

   Note: (Performance Center Host only). While you can participate in the VuGen improvement program by selecting Participate in VuGen improvement program, we do not recommend it because it creates unnecessary overhead on the host machine.

   The program helps us improve the quality, reliability, and performance of Performance Center by enabling it to collect anonymous information about your software and hardware configuration, and about how you use Performance Center. For details, click More Details in the user interface.

   Click Next.

7. Select a destination folder.
   Specify the location in which to install the Performance Center component. To browse possible locations, click the Browse button, select a location, and click OK.

   Note: (Performance Center Host only). To reduce problems due to the Microsoft
Windows API path limitation, choose a short name for your installation directory path. For example: “C:\PCHost”.

Click Next.

8. **Start the installation process.**

The wizard prompts you to confirm the details and start the installation. To review or change any settings, click Back.

Click Install to start the installation. The wizard displays the installation progress.

Upon completion of the installation, the Welcome page of the Configuration wizard opens.

Click Next.

9. **Enter the Communication Security passphrase.**

Enter the Communication Security passphrase for secure communication between the Performance Center server and ALM. This must be identical to the passphrase defined during the ALM installation. You can view the passphrase in Site Administration > Site Configuration tab > COMMUNICATION_SECURITY_PASSPHRASE parameter. For details, refer to the Application Lifecycle Management Administrator Guide.

Click Next.

10. **Create the Performance Center User (Performance Center Server only).**

Performance Center requires that a system user is created for use by the Performance Center server, hosts and the Load Generator standalone machines.

To define a system user for the Performance Center environment, enter the user and password.

Note:

- You can use a local or a domain user. When using a local user, if the user does not exist on the Performance Center server machine, the installer will create it.
- When using a local user, if the user name does not exist or is not in the Administrators group, it will be added to the Administrators group.
- After adding the Performance Center server to the Lab Management project, the Performance Center user will be saved to that database. Each subsequent Performance Center server or host added, will be configured with that user.
- After a Performance Center server is added to the ALM platform, you can use the System Identity utility (\<Performance Center server installation directory>/bin/IdentityChangerUtil.exe) to change the user. For details, see the Administration section in the Performance Center Help.
Once you succeed in creating the user and configuring the server, the next time you launch the configuration wizard, this page will not be displayed.

11. **Choose the IIS Web Site (Performance Center Server only).**  
Select the IIS web site to be used by the Performance Center server.  
Click **Next**.

   **Note:** If only one web site exists on IIS, this page will not be displayed. The installation will use the exiting web site.

12. **Confirm the configuration.**  
The Confirm Configuration page opens.  
Click **Next**.

13. **The background configuration starts.**  
The wizard displays the progress bar as it performs the configurations on the relevant component.  
The wizard performs the following configurations on the relevant component:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>PC Server</th>
<th>PC Host</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies and updates configuration files.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Creates the Performance Center system user</td>
<td>Yes</td>
<td>No (The user is created when adding a host to Performance Center Administration)</td>
</tr>
<tr>
<td>For information about changing the system user, see &quot;Change the Performance Center system user&quot; in the <em>Performance Center Administration Guide</em>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configures DCOM objects.</td>
<td>No (the DCOM objects are configured when adding a server to Performance Center Administration)</td>
<td>No (the DCOM objects are configured when adding a host to Performance Center Administration)</td>
</tr>
<tr>
<td>Configuration</td>
<td>PC Server</td>
<td>PC Host</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Installs Performance Center services:</td>
<td>Yes</td>
<td>Yes (except for Performance Center Alerts Service)</td>
</tr>
<tr>
<td>• DataCollectionAgent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• RemoteManagement Agent Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Performance Center Alerts Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> For details on how to reconfigure the port used by the DataCollectionAgent service, see Software Self-solve knowledge base article KM01526547.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Installs Performance Center services:</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>• Performance Center Agent Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Performance Center Data Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Performance Center Load Testing Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Performance Center Analytics Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you stop the Performance Center Analytics Service, the test will still run but there will be no online or offline results available. You can still collate and analyze results.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configuration

<table>
<thead>
<tr>
<th><strong>Configures IIS:</strong></th>
<th><strong>PC Server</strong></th>
<th><strong>PC Host</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Creates virtual directories and application pools.</td>
<td>Yes</td>
<td>--</td>
</tr>
<tr>
<td>Configures IIS application pools to work as 32-bit application pools.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sets the .NET version for the application pools to .NET 4 (v4.0.30319).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sets Integrated mode for the application pools.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sets read and write permissions for the Modules feature.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updates Mime type list.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**IIS 7.5:**

- Enables Windows communication foundation.
- Disables rules: Web-Url-Auth

**IIS 8.0/8.5/10:**

- Disables rules: IIS-URLAuthorization


When the configuration is complete, the wizard confirms the configuration status. Click **Finish** to exit the Configuration wizard.

**Note:** The configuration log files are available from:

- Server: `<installation folder>\orchidtmp\Configuration\configurationWizardLog_pcs.txt`
15. **Download and install the latest Performance Center patch (if any).**

For details, see "Upgrading to the latest Performance Center patch" on page 69.

16. **Complete the Performance Center installation and determine whether to install Network Virtualization (NV).**

The Finish page opens.

You can continue with the NV installation, or choose to install manually at a later time. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical</td>
<td>Launches a non-interactive NV installation, using the default NV settings.</td>
</tr>
<tr>
<td>Custom</td>
<td>Launches an interactive NV installation, enabling you to set the installation folder, data folder, and port to be used, and select which NV components to install.</td>
</tr>
<tr>
<td>Do not install NV</td>
<td>NV will not be installed.</td>
</tr>
</tbody>
</table>

Click **Finish** to close the Performance Center installer and proceed with your selected NV installation option.

**Note:**

- The Performance Center installation is complete, regardless of selected NV installation option.
- If you are installing NV on a Performance Center server, the NV for Performance Center server installation will be launched.
- If you are installing NV on a Performance Center host, both the NV for Controller and the NV for Load Generator installations will be launched (one after the other).
- For more details on the NV installation, see the Installation section of the Network Virtualization for Performance Testing Help Center.

17. **Add the Performance Center server to the Trusted Sites of the client’s machine browser.**

a. In Internet Explorer, select **Tools > Internet Options**. The Internet Options dialog box opens.
b. In the **Security** tab, select **Trusted Sites**, and click **Sites**.

c. If you are not using SSL, ensure that the **Require Server verification (https:) for all sites in this zone** option is not selected.

d. In the **Add this website to the zone** box, enter the Performance Center server internal URL (http://<Performance Center server name>/loadtest), and click **Add**.

18. **Perform additional required Performance Center configuration steps.**

For details, see "Configuring Performance Center" below.

---

**Configuring Performance Center**

After running the Performance Center Server installation and the Performance Center Server Configuration wizard, you must perform additional configuration steps in Lab Management and Performance Center Administration before you can use the product.

This section includes:

- "Configuring Performance Center using the Configuration Wizard" below
- "Adding the Performance Center Server to the System (Lab Management)" below
- "Logging on to Performance Center Administration" on the next page
- "Adding or reconfiguring Performance Center Hosts" on page 44
- "Running a System Health Check" on page 45
- "Setting the License Keys" on page 45

**Configuring Performance Center using the Configuration Wizard**

While you configure Performance Center servers and hosts during the installation process, you can also configure them separately from the installation using the Configuration Wizard from the Start menu. To do so, you must run the wizard as an administrator.

1. **Prerequisites**

   Install Performance Center. For details, see "Installing and Configuring Performance Center Servers and Hosts" on page 34.

2. **Launch the Server Configuration Wizard** or **Host Configuration Wizard** from the Start menu using the **Run as administrator** option.

   Alternatively, choose **Start > All Programs > Micro Focus > Performance Center Server/Host > Tools**, right-click **Server/Host Configuration Wizard**, and select **Run as administrator**.

**Adding the Performance Center Server to the System (Lab Management)**

To use the Performance Center server, it must be defined in ALM Lab Management.
Note:

- You need to add at least one Performance Center server from Lab Management. Thereafter, you can add and manage Performance Center servers and other resources from Performance Center Administration.
- From a performance and fault tolerance perspective, it is strongly recommended to define at least two Performance Center servers.

To define the Performance Center server:

1. Log on to Lab Management.
   a. Open the Web browser and type the ALM URL:
      http://<ALM server name>[:<port number>]/qcbin.
      The ALM Options window opens.
   b. Click Lab Management, enter the user name and password of a Site Administrator, and click Login.
2. On the Lab Management sidebar, under Servers, select PC Servers.
3. In the Lab Management toolbar, click ALM Connection. In the ALM Connection dialog box, enter the ALM Internal and ALM External URLs that are used by the Performance Center server to connect to the ALM platform.
4. For each Performance Center server:
   a. In the PC Servers module, click New PC Server.
   b. Enter the details of the Performance Center server as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the Performance Center server.</td>
</tr>
<tr>
<td>External URL</td>
<td>The URL for accessing the Performance Center server from external sources.</td>
</tr>
<tr>
<td>Internal URL</td>
<td>The URL for accessing the Performance Center server from within the system. For example, the Performance Center server and ALM communicate with each other through this URL.</td>
</tr>
<tr>
<td>Status</td>
<td>Make sure that the Performance Center server's status is <strong>Operational</strong> so that ALM and other Performance Center components can access it.</td>
</tr>
</tbody>
</table>

Logging on to Performance Center Administration

After adding a Performance Center server to the system from Lab Management, you can add additional Performance Center servers and manage other test resources (such as Performance Center...
Center hosts) from Performance Center Administration.

**To log on to Performance Center Administration:**

1. Open your Web browser and type the Performance Center Administration URL in the following format:

   http://<Performance_Center_Server_name>/admin

   The Performance Center Administration Login window opens.

2. Enter the user name and password of the Performance Center administrator, and click Login.

   Performance Center Administration opens.

### Adding or reconfiguring Performance Center Hosts

To work with the Performance Center hosts, you must add them to Performance Center and/or reconfigure existing hosts if you are upgrading from an existing project.

### Adding hosts

To work with Performance Center hosts, you must first add them to Performance Center Administration. To add a host, you must define the host's location in Performance Center Administration. If the host is a load generator over a firewall, you must define the MI Listener through which the load generator will communicate with the Performance Center server.

**Note:**

- Before adding a host, ensure that at least one Performance Center server is in an operational state.
- When adding the hosts, fields in red marked with an asterisk (*) are mandatory, including the type of operating system, and the purpose of the host. For details, see the Manage Hosts section in the Performance Center Help.
- When adding the hosts, the system configures the Performance Center user on that machine.

**To add hosts:**

1. **Log onto Performance Center Administration.**
   
   For details, see "Logging on to Performance Center Administration" on the previous page.

2. **Add the host's location.**
   
   a. In Performance Center Administration, select Maintenance > Hosts, and click the Locations tab.
   
   b. Click Add New Location, and enter the host location's details.

3. **For a host over a firewall, add the MI Listener.**
a. Under **Maintenance > Hosts**, click the **MI Listeners** tab.
b. Click **Add New MI Listener** †, and enter the MI Listener’s details.

4. **Add the host.**
   a. Under **Maintenance > Hosts**, click the **Hosts** tab.
b. Click **New Testing Host** †, and enter the host’s details. In particular:
   ○ In the **Installation** field, select the type of host installation: **Windows Host; Windows Standalone LG; UNIX Load Generator**.
   ○ In the **Purpose** field, select a purpose for the host.

Reconfiguring hosts after upgrading an existing LAB project

If you upgrade an existing LAB Project (after uninstalling the previous version of Performance Center, and installing Performance Center 12.60 on the hosts), Performance Center hosts are displayed in the **Unavailable** state, and you need to perform the following:

1. In Performance Center Administration, select **Management > Hosts**.
2. Select the hosts you want to reconfigure in the Hosts grid, and click **Reconfigure Host**.

Running a System Health Check

After adding a Performance Center server to the system from Lab Management, and adding or reconfiguring Performance Center hosts, you should perform a system health check to make sure all components are running as expected.

**To perform a system check:**

1. In Performance Center Administration, select **Maintenance > System Health**, and in the **Health Check** tab, click **Check System**.
2. Select all the system components (ALM Platform, Performance Center servers, Performance Center hosts), and then click **Start** to check system health for each machine.
3. Check the results when the health check has finished. For details, see Maintain system health in the **Performance Center Help**.

Setting the License Keys

After you add the Performance Center server to ALM, you are required to enter your Performance Center server and host licenses.

**Note:** After installing Performance Center 12.60, you will have a Community license only (if you are upgrading your LAB project, your previous licenses will be removed). Therefore, you will need to upload new licenses as described in "Adding Performance Center Licenses" on the next page.
License Types

<table>
<thead>
<tr>
<th>License Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Center license</td>
<td>Enables you to use the product and run performance tests. This license determines the number of performance tests that you can run concurrently, and the total number of Vusers available for the performance tests.</td>
</tr>
<tr>
<td>Performance Center Host license</td>
<td>Defines the Vuser protocols, monitors, and modules that are available on each host machine. This license also determines the number of Vusers available per protocol.</td>
</tr>
<tr>
<td>Performance Center Community License Bundle</td>
<td>Performance Center is delivered with a free perpetual community license bundle. The bundle includes:</td>
</tr>
<tr>
<td></td>
<td>1 Controller allowing 1 concurrent run, 1 PC Lifecycle user, 50 permanent Vusers, free use of Network Virtualization, Mobile UI (unlimited), and TruWeb (unlimited) which is provided as a tech preview version. The Vusers are valid for all protocols except for GUI (UFT), COM/DCOM, and template protocols. The community license bundle does not include support.</td>
</tr>
</tbody>
</table>

**Note:** This license bundle is installed when Performance Center is first installed.

Adding Performance Center Licenses

1. **Prerequisites.**
   Make sure the ALM license is set in the ALM Site Administration. For details about the ALM license, see the Manage Licenses section in the ALM Help Center.

   **Note:** An evaluation ALM license key for Performance Center standalone is available from the `<Performance Center installation directory>\CommunityLicense` folder.

2. **Obtain your license keys.**
   Due to changes in Performance Center licensing in version 12.60, you need to replace your current license to enable working with Performance Center 12.60.

   To obtain a Performance Center license:
   - If you have a valid order number or subscription name (SAID), go to Software Licenses and Downloads Portal to get software downloads and license keys for Performance Center 12.60.
If you are an existing customer, click the **Update** link available on the portal to get new license key(s) required for version 12.60.

For more information, see the instructions provided in the portal's **Contact Us / Self Help page**, or click **Contact Licensing Delivery Center** to request assistance if required.

3. **Activate your license keys.**

Select your account in the **Software Licenses and Downloads Portal**, and follow the onscreen instructions to activate your licenses.

| Note: If you are using the community license bundle installed with Performance Center, license activation is not required. |

4. **Set your license keys.**

You can set the licenses from the following areas:

a. In Performance Center Administration, select **Configuration > Licenses**. The Licenses page opens. For details, see Manage Licenses in the **Performance Center Help**.

b. Click **Add License** and select one of the following options:
   - **Load License**. Adds a single license key.
   - **Load from File**. Adds multiple license keys simultaneously.

### Installing Performance Center Silently

A **silent installation** is an installation that is performed automatically, without the need for user interaction. This section describes how to perform a silent installation of Performance Center components.

Before you perform the installation, review the pre-installation information, including the system requirements, described in "**Before You Install**" on page 9.

This section includes:

- "**Silent Installation of Prerequisite Software**" below
- "**Setting Up the Silent Configuration**" on page 49
- "**Silent Installation of Performance Center Server and Performance Center Hosts**" on page 51

### Silent Installation of Prerequisite Software

Install the prerequisite software silently by running the relevant commands as follows:
<table>
<thead>
<tr>
<th>Prerequisite Software</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>.NET Framework 4.6.2</strong></td>
<td>`&lt;Installation_Disk_Root_Directory&gt;\Setup\Common\dotnet462\NDP462-</td>
</tr>
<tr>
<td></td>
<td>KB3151800-x86-x64-AllOS-ENU.exe /LCID /q /norestart /c:&quot;install</td>
</tr>
<tr>
<td></td>
<td>/q&quot;</td>
</tr>
<tr>
<td></td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td></td>
<td>• .NET Framework 4.6.2 replaces the .NET Framework 4.0 files. If there</td>
</tr>
<tr>
<td></td>
<td>are any applications that are using the .NET Framework 4.0 files and</td>
</tr>
<tr>
<td></td>
<td>are running during the installation of .NET Framework 4.0 files, you</td>
</tr>
<tr>
<td></td>
<td>may need to restart your machine. If you are prompted to restart the</td>
</tr>
<tr>
<td></td>
<td>machine, restart it before continuing the installation. For details,</td>
</tr>
<tr>
<td></td>
<td><strong>Microsoft Visual C++ Redistributable for Visual Studio 2015</strong></td>
</tr>
<tr>
<td></td>
<td>`&lt;Installation_Disk_Root_Directory&gt;\Setup\Common\vc2015_redist_</td>
</tr>
<tr>
<td></td>
<td>x86\vc_redist.x86.exe /quiet /norestart</td>
</tr>
<tr>
<td></td>
<td><strong>Microsoft Visual C++ Redistributable for Visual Studio 2015 (x64)</strong></td>
</tr>
<tr>
<td></td>
<td>`&lt;Installation_Disk_Root_Directory&gt;\Setup\Common\vc2015_redist_</td>
</tr>
<tr>
<td></td>
<td>x64\vc_redist.x64.exe /quiet /norestart</td>
</tr>
<tr>
<td></td>
<td><strong>Windows Imaging Component (WIC)</strong></td>
</tr>
<tr>
<td></td>
<td>`&lt;Installation_Disk_Root_Directory&gt;\Setup\Common\dotnet40\wic_x64_enu</td>
</tr>
<tr>
<td></td>
<td>.exe /q /norestart</td>
</tr>
<tr>
<td></td>
<td><strong>Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)</strong></td>
</tr>
<tr>
<td></td>
<td>`&lt;Installation_Disk_Root_Directory&gt;\Setup&lt;environment&gt;\prerequisites</td>
</tr>
<tr>
<td></td>
<td>mdac28\mdac28.exe /q:A /C:&quot;setup /QNT&quot;</td>
</tr>
<tr>
<td></td>
<td><strong>Microsoft Core XML Services (MSXML) 6.0</strong></td>
</tr>
<tr>
<td></td>
<td>For x64: msiexec /log c:\msxml.log /quiet /I &lt;Installation_Disk_Root_</td>
</tr>
<tr>
<td></td>
<td>Directory&gt;\Common\msxml6\msxml6_x64.msi</td>
</tr>
<tr>
<td></td>
<td>For ia64: msiexec /log c:\msxml.log /quiet /I &lt;Installation_Disk_Root_</td>
</tr>
<tr>
<td></td>
<td>Directory&gt;\Common\msxml6\msxml6_ia64.msi</td>
</tr>
<tr>
<td>Prerequisite Software</td>
<td>Command</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Microsoft Windows Installer 3.1</td>
<td>&lt;Installation_Disk_Root_Directory&gt;\Setup\Common\msi31\WindowsInstaller-KB893803-v2-x86.exe /q /norestart</td>
</tr>
</tbody>
</table>
| Internet Information Services (IIS) | See the Microsoft documentation for the PowerShell command required for your IIS version.  
**Note:** Performance Center Server only. |

**Setting Up the Silent Configuration**

This section describes how to customize the file used for silent configuration of the Performance Center. The *UserInput.xml* file—installed with Performance Center—contains parameters for the Performance Center server and Performance Center host configurations.

You can customize the parameters in the *UserInput.xml* file. You then instruct the Installer to use the customized file for the silent configuration input.

**To configure the properties in the UserInput.xml file:**

1. Copy the *UserInput.xml* file from the Performance Center installation directory (`...\Setup\Install\[Host][Server]\`) to another location.
2. Open the copy of the file and enter a user-defined value for the following property:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LW_CRYPTO_INIT_STRING</td>
<td>This passphrase must be identical to the passphrase defined during the ALM installation.</td>
</tr>
</tbody>
</table>
3. **For Performance Center Server only:**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IIS_WEB_SITE_NAME</td>
<td>Choose the IIS web site that will be used to host the Performance Center server services.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• The web site must exist prior to running the configuration.</td>
</tr>
<tr>
<td></td>
<td>• The value is optional. If no web site is specified and there is more than one defined on your machine, the configuration will use the first one (the one with the smallest ID value).</td>
</tr>
<tr>
<td>SystemUserName</td>
<td>Choose the name of the user that will be configured as the Performance Center Windows system user.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You can use a local or a domain user:</td>
</tr>
<tr>
<td></td>
<td>• If you are using a local user, the user will be added to the Administrator group.</td>
</tr>
<tr>
<td></td>
<td>• If you are using a domain user, the value for this property should be in the form of <code>&lt;domain\user&gt;</code>. Make sure the machine and the user are part of the same domain and that the user exists on the machine.</td>
</tr>
<tr>
<td></td>
<td>• If you do not provide a user name, the system will use the default user name (IUSR_METRO).</td>
</tr>
<tr>
<td></td>
<td>• A user name cannot include the following characters: [ ]:</td>
</tr>
<tr>
<td></td>
<td>• If the supplied user's details are invalid (for example, the user name contains invalid characters, or the domain user does not exist), the system will use the default user name (IUSR_METRO) instead.</td>
</tr>
</tbody>
</table>

For details on defining a user, see "Installing and Configuring Performance Center Servers and Hosts" on page 34.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SystemUserPwd</td>
<td>Choose the password for the Performance Center Windows system user.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• If the installer uses the default user (for example, when the value for</td>
</tr>
<tr>
<td></td>
<td>property 'SystemUserName' is empty), the password property will be</td>
</tr>
<tr>
<td></td>
<td>ignored and the installer will use the default password ('P3rfoRm@1nce').</td>
</tr>
<tr>
<td></td>
<td>• A password cannot include the following characters <code>&lt;</code></td>
</tr>
<tr>
<td></td>
<td>• A password cannot be empty. If this field is left empty, the system</td>
</tr>
<tr>
<td></td>
<td>will use the default password ('P3rfoRm@1nce').</td>
</tr>
<tr>
<td></td>
<td>• If using an existing user for the ‘SystemUserName’ property, the</td>
</tr>
<tr>
<td></td>
<td>password must match the password used by the existing user.</td>
</tr>
</tbody>
</table>

4. **For Performance Center Host only:**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LRASPCHOST=1</td>
<td>Add this property to install LoadRunner as a Performance Center Host.</td>
</tr>
<tr>
<td>IMPROVEMENTPROGRAM=0</td>
<td>The option to participate in the VuGen improvement program is enabled by</td>
</tr>
<tr>
<td></td>
<td>default. Add this property if you want to disable it. For details, see</td>
</tr>
<tr>
<td></td>
<td>VuGen improvement program.</td>
</tr>
</tbody>
</table>

5. Save the **UserInput.xml** file.

6. Specify the location of the saved file when running the silent installation command.

**Silent Installation of Performance Center Server and Performance Center Hosts**

This section describes how to run the silent installation of the Performance Center server and Performance Center hosts on a Windows platform.

The silent installation is followed by the silent configuration which calls the **UserInput.xml** file for configuration parameters. You can customize the parameters in this file for the Performance Center server configuration. For details, see "Setting Up the Silent Configuration" on page 49.

**To perform a silent installation of Performance Center, use one of the following options:**
Option 1: Install the prerequisite software and the Performance Center component.
   a. Install the prerequisite software. For details, see "Silent Installation of Prerequisite Software" on page 47.

   ![Note] If you are prompted to restart the computer after installing the prerequisite software, you must do so before continuing with the installation.

   b. After you have installed all the prerequisite software, install the Performance Center component by running the appropriate command from the command line.

   **Performance Center Server:**

   | Silent installation with default properties | msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\Server\PCServer.msi  
   | INSTALLDIR="<Target Installation Directory>" NVINSTALL=Y /qn /l*vx "<Path to log file>" |

   | Silent installation with customized UserInput.xml | msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\Server\PCServer.msi  
   | USER_CONFIG_FILE_PATH="<Full path to UserInput file>"  
   | INSTALLDIR="<Target Installation Directory>" NVINSTALL=Y /qn /l*vx "<Path to log file>" |

   Where `<Full path to UserInput file>` is the path to your customized UserInput.xml file,  
   `<Target Installation Directory>` is the directory in which to install the Performance Center server, and `<Path to log file>` is full path to the installation log file.

   **NVINSTALL** indicates whether to launch the NV installation in silent mode, once the Performance Center installation is done (by default, NV is not installed in silent mode).

   ![Note] Restarting the machine is required in order for NV to function properly.

   **Performance Center Host:**

   msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\Host\LoadRunner_x64.msi  
   USER_CONFIG_FILE_PATH="<Full path to UserInput file>" [optional installer properties - see list below] /qn /l*vx "<Path to log file>"

   Where `<Full path to UserInput file>` is the path to your customized UserInput.xml file,  
   `<Target Installation Directory>` is the directory in which you want to install the Performance Center host, and `<Path to log file>` is full path to installation log file.
NVINSTALL indicates whether to launch the NV installation in silent mode, once the Performance Center installation is done (by default, NV is not installed in silent mode).

**Note:** Restarting the machine is required in order for NV to function properly.

- **Option 2:** Install the prerequisite softwares together with the Performance Center components.
  You can also install in silent mode using the setup.exe file from the Performance Center installation directory. This enables you to install the prerequisites in silent mode automatically before running the MSI installation in silent mode. Using this option also invokes the correct MSI file depending on the operating system platform.

  **Server installation:**
  
  ```
  <Installation_Disk_Root_Directory>\Setup\En\setup_server.exe /s USER_CONFIG_FILE_PATH="<Full path to UserInput file>" INSTALLDIR="<Target Installation Directory>" NVINSTALL=Y
  ```

  **Host installation:**
  
  ```
  <Installation_Disk_Root_Directory>\Setup\En\setup_host.exe /s INSTALLDIR="<Target Installation Directory>" USER_CONFIG_FILE_PATH="<Full path to UserInput file>" NVINSTALL=Y
  ```

  Where `<Full path to UserInput file>` is the path to your customized UserInput.xml file and `<Target Installation Directory>` is the directory in which to install the Performance Center server or host.

  When using the `setup.exe` file, the installation log will be created under the user's temp directory.

  **Host installation:** `%temp%\PCHost.log.
  **Server installation:** `%temp%\PCSServer.log.

  Where `<Full path to UserInput file>` is the path to your customized UserInput.xml file, `<Target Installation Directory>` is the directory in which you want to install the Performance Center host, and `<Path to log file>` is full path to installation log file.

  NVINSTALL indicates whether to launch the NV installation in silent mode, once the Performance Center installation is done (by default, NV is not installed in silent mode).

  **Note:** Restarting the machine is required in order for NV to function properly.
Installing Standalone Components (Windows)

You can install standalone components that provide advanced features for working with Performance Center.

To install a load generator on Linux, see "Installing Load Generator on Linux" on page 57.

---

**Note:** For all standalone applications, you must first manually install the prerequisite applications. For details, see "Silent Installation of Prerequisite Software" on page 47

This section includes:

- "Available Standalone Components for Windows" below
- "Installing Standalone Components" on the next page
- "Silent Installation of the Standalone Applications" on page 56

Available Standalone Components for Windows

The following standalone components are available. To install these components, see "Installing Standalone Components" on the next page.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Generator</td>
<td>Instead of installing a Performance Center Host and then configuring it as a load generator, you can install a standalone version of the load generator. This host can behave only as a load generator, unlike the Performance Center host, which can also be configured as a Controller or data processor. You can use a local or a cloud-based machine to host your load generator.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you know in advance that a particular host machine is to be used as a load generator only, we recommend that you install the standalone Load Generator for the following reasons:</td>
</tr>
<tr>
<td></td>
<td>- The installation requires less disk space</td>
</tr>
<tr>
<td></td>
<td>- Moving the Load Generator's setup files is less time consuming than moving the setup files of the Performance Center Host.</td>
</tr>
<tr>
<td>Virtual User Generator</td>
<td>Virtual User Generator (VuGen) generates virtual users, or Vusers, by recording actions that typical end-users would perform on your application. VuGen records your actions into automated Vuser scripts which form the foundation of your performance tests.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LoadRunner Analysis</td>
<td>Analysis provides graphs and reports with in-depth performance analysis information. Using these graphs and reports, you can pinpoint and identify the bottlenecks in your application and determine what changes need to be made to your system in order to improve its performance.</td>
</tr>
<tr>
<td>TruClient</td>
<td>TruClient is a browser-based testing technology for creating test scripts that can then be used in performance testing or monitoring web applications. TruClient records your actions as you navigate through your business process. It creates a script from your actions—which you then run in performance testing.</td>
</tr>
<tr>
<td>MI Listener</td>
<td>The MI Listener is one of the components needed to run Vusers and monitor applications over a firewall. To install, run SetupMIListener.exe. For details about firewalls in Performance Center, see &quot;Working with Firewalls&quot; on page 99.</td>
</tr>
<tr>
<td>Monitor Over Firewall Agent</td>
<td>Used to monitor servers that are located over a firewall. For details about firewalls in Performance Center, see &quot;Working with Firewalls&quot; on page 99.</td>
</tr>
</tbody>
</table>

Installing Standalone Components

This section describes the installation process for standalone components.

**To install any of the standalone components:**

1. From the Performance Center installation directory, run setup.exe. The setup program displays the installation menu page.
2. Select one of the following options: Load Generator, Virtual User Generator, Analysis, TruClient, MI Listener, or Monitor Over Firewall. For details, see the LoadRunner Installation Guide available from the LoadRunner Help Center.

**Note:**

- During the installation of Load Generator Standalone, MI Listener, or Monitors over Firewall components, the setup wizard prompts you to select the mode for running the installed agent. Select Performance Center mode.

The agent runs as a service under a special account named IUSR_Metro. This is a local Windows account, created during the installation process (some additional Performance Center configuration is also added on the load generator).
You can delete the IUSR_Metro account only if the Performance Center system user was configured to a different Windows account; otherwise the host will not function correctly.

- If you attempt to install standalone components on a system drive other than the default C drive, you will get a warning that you are out of disk space on your system drive even though you are not installing there. This is because the installer, while installing the components to the drive as specified by the user, still needs to use the Windows temporary file locations during installation. **Workaround:** Free up space on your C system drive.

3. **MI Listener/Monitor Over Firewall installations only:** Follow the instructions in the installation wizard. After installation, the configuration wizard opens, requesting the name of the product you are working with. Select **Performance Center**.

**Silent Installation of the Standalone Applications**

This section describes how to perform a silent installation of the standalone applications.

**Note:** For instructions on installing the Load Generator silently on Linux, see the LoadRunner Installation Guide available from the LoadRunner Help Center.

Choose one of the following options:

**Option 1: Install the prerequisite software and the application separately**

1. Install required prerequisite software. For details, see "Silent Installation of Prerequisite Software" on page 47.
2. Extract the Load Generator installation files to a local directory:
   a. Select an application from the `<Installation_Disk_Root_Directory>\Standalone Applications` folder.
   b. Extract the `.msi` file from the `.exe` application to the installation folder.
3. Run one of the following commands from the command line:
   - **Load Generator:**
     ```
     msiexec /i "<Installation_Folder>\LoadGenerator_x64.msi" /qb /l*vx "<Path to log file>" IS_RUNAS_SERVICE=1 START_LGA="1"
     ```
   - **VuGen Standalone:**
     ```
     msiexec /i "<Installation_Folder>\VuGen_x64.msi" /qb /l*vx "<Path to log file>"
     ```
Analysis Standalone:

```
msiexec /i "<Installation_Folder>\Analysis_x64.msi" /qb /l*vx
"<Path to log file>"
```

where `<Installation_Folder>` is the local directory where you saved the installation files, and `<Path to log file>` is the full path to the installation log file.

**Note:** You can install the Load Generator component on a Linux platform to run virtual users. The Linux virtual users interact with the Controller, installed on a Windows machine. For details on installing the Load Generator on Linux, see the LoadRunner Installation Guide available from the LoadRunner Help Center.

Option 2: Install the prerequisite software and the application together

1. Select an application from the `<Performance Center installation directory>\Additional Component\Applications` folder.
2. Run one of the following commands from the command line:

   - **Load Generator:**
     ```
     SetupLoadGenerator.exe /s /a IS_RUNAS_SERVICE=1 START_LGA="1" /s
     ```

   - **VuGen Standalone:**
     ```
     SetupVuGen.exe /s /a /s
     ```

   - **Analysis Standalone:**
     ```
     SetupAnalysis.exe /s /a /s
     ```

Installing Load Generator on Linux

You can install the Load Generator component on a Linux platform to run virtual users. The Linux virtual users interact with the Controller, installed on a Windows machine. For details on installing the Load Generator on Linux, see the LoadRunner Installation Guide available from the LoadRunner Help Center.

Deploying Dockerized Load Generators on Linux

This section describes how to run a dockerized load generator on a Linux distribution.
Docker is a platform that allows you to develop, ship, and run applications via a container. For details regarding Docker, see [https://docs.docker.com](https://docs.docker.com).

**Prerequisites**

- Install Docker on the target machine, along with its dependencies, and set up the target machine environment as required. Currently, only the 64-bit version is supported. For installation details, see [https://docs.docker.com/install/](https://docs.docker.com/install/).
- Obtain the predefined load generator Docker image:
  - Pull from the Docker hub, [Linux Dockerized Load Generator](https://hub.docker.com/r/performancetesting/load_generator_linux/), using the following command and appropriate `<tag version number>`, for example, 12.60:

    ```bash
    docker pull performancetesting/load_generator_linux:<tag version number>
    ```
  - Use the image provided in the Performance Center installation package (in the `InsData` folder of the ISO file). Import the image from the tar archive using the following command:

    ```bash
    docker load < load_generator.tar
    ```

**Run a dockerized load generator using the predefined image**

Use the ready-to-use image to run a load generator on Docker for Linux.

**Note:** If you need customization for your container, for example, for proxy servers, see "Run a dockerized load generator using a custom image" on the next page.

**To run a dockerized load generator:**

Run the load generator container using the following command:

```bash
docker run -id -p <host_port>:54345 performancetesting/load_generator_linux:<tag version number>
```

**Note:** Check that the `<host_port>` on the Linux machine is available and allows incoming requests. You will specify this port on the Controller side when connecting to this load generator.
Example using SSH

The following gives a simple C# code example for running multiple load generator containers using SSH. There are container orchestrator tools which do the same, for example, Kubernetes, OpenShift, Docker Swarm, and more.

```csharp
using (var client = new SshClient(dockerHost, dockerHostUserName, dockerHostPasswd))
{
    client.Connect();
    for (int i = 0; i < numOfContainers; i++)
    {
        string command = "docker run -id -p " + lgInitialPort + i + ":54345 perfomancetesting/load_generator_linux:<tag version number>";
        var terminal = client.RunCommand(command);
        if (terminal.ExitStatus != 0)
        {
            throw new Exception("Failed to create new Docker container");
        }
        Console.WriteLine("Docker LG with external port " + lgInitialPort + i + "created.");
    }
    client.Disconnect();
}
```

Run a dockerized load generator using a custom image

If your environment requires customized settings for running the container, for example for proxy servers, you can create a Dockerfile to build a custom image.

**Note:** Another alternative for customized settings: Start the container; once it is running, set up the load generator environment variables, then start the load generator manually inside the container.

To run a custom dockerized load generator:

1. Create a new folder, and within it create a file named `dockerfile`. Paste the `FROM` line, plus the required customization lines, into the file, using the appropriate PC version for the `<tag version number>`:

   **Note:** This customization example is for proxy. It defines an environment variable for the proxy server host and port in the target image.
FROM performancetesting/load_generator_linux:<tag version number>
ENV http_proxy http://my_proxy_name:port

**Note:** The above customization example is for a proxy. It defines an environment variable for the proxy server host and port in the target image.

2. Save the Dockerfile.

3. Open a command line at the **dockerfile** folder path and run the following command, using the name you want for your custom image:

   ```bash
docker build -t <custom dockerfile name> .
   ```

4. Create a container for each load generator you want to use, by running the following command:

   ```bash
docker run -id -p <host_port>:54345 <custom image name>
   ```

   **Note:** Check that the `<host_port>` on the Linux machine is available and allows incoming requests. You will specify this port on the Controller side when connecting to this load generator.

   If the custom image in step 3 was built with a tag then include it in the command:

   ```bash
docker run -id -p <host_port>:54345 <custom image name>:<tag version number>
   ```

**After running the load generator containers**

Add the load generators containers to your tests.

- For elastic hosts, see [Set up elastic hosts on Windows or Linux container](#) in the Performance Center Help.
- For manually configure dockerized load generators, see [Add dockerized load generators to your tests](#) in the Performance Center Help.

**Build a Custom Dockerfile Image**

Use the sample Dockerfile content provided below as a basis for your custom file, and edit to fit your specific needs. Once you have the file, follow these steps to build a Docker image:
1. Place your Dockerfile and the load generator installation folder, VM (containing inst64.bin, unzip, and installer.sh), together in the same folder.
2. Switch to root user. Make sure you have Internet access and the ability to install dependencies.
3. In the directory which contains the Dockerfile, type:

   ```
   docker build -t load_generator ./
   ```

**Sample Dockerfile Content**

The following example shows how to build a Linux image. It sets a proxy enabling the container to connect to the Internet and then installs the load generator prerequisites. It then copies the load generator installation files to the container and installs it silently. Lastly, it sets an ENTRYPOINT which tells the container what to execute when starting.

```
# sudo docker build -t load_generator /

# Set the base image
FROM ubuntu:14.04

# Set the proxy
# ENV http_proxy http://my_proxy_name:port

# Install prerequisites for Load Generator
RUN dpkg --add-architecture i386
RUN apt-get update && apt-get install -y libc6-i386 lib32stdc++6 lib32ncurses5 libkeyutils1:i386 libglib2.0-0:i386 libidn11:i386

# Copy the Load Generator installation files to a temporary folder
RUN mkdir /opt/tmp_LG
ADD VM /opt/tmp_LG

# Install the Load Generator
RUN /bin/bash -c "cd /opt/tmp_lg; source ./installer.sh -i silent"

# Remove the installation files
```
RUN rm -R /opt/tmp_LG

#Start the container. If you need entry to the container, add --entrypoint to overwrite the ENTRYPOINT. If you do not need entry to the container, use "-id" to start the container.

ENTRYPOINT ["/bin/bash","-c","cd /opt/MF/MF_LoadGenerator/; source env.sh; cd bin/; ./m_daemon_setup -install; while true; do cat; done"]

Tips and guidelines

- Dockerized load generators, run from the predefined image, are not supported when running over a firewall. (Workaround for advanced users: You can develop your own Docker image with MI Listener support.)
- Use docker ps to list the containers that are running.
- To stop the load generator service:
  - Use docker stop <load generator container name or ID> if you want to reuse the same load generator.
  - Use docker rm -f <load generator container name or ID> in order to remove the load generator container.
- The Dockerfile container has an ENTRYPOINT section. The container first runs the commands in ENTRYPOINT. It sets up the environment and then starts the load generator. The command uses a While loop to wait for input, in order to keep the container from exiting. This behavior prevents you from accessing the container while it is running. Make sure to add -i while starting the container; otherwise the While loop will consume an excessive amount of CPU.
- If you need entry into the container, add an argument such as --entrypoint=/bin/bash when starting the container. After entering the container, set the load generator environments and start the load generator. You can then switch to the host using CTRL+p and CTRL+q while keeping the container running in the background. To access the container again, use the docker attach container_id command.
- To access the host network directly, use --net=host in place of -p <host_port>:54345. We recommend you use this flag if the AUT generates a lot of network activity.

Deploying Dockerized Load Generators or Controllers on Windows

This section describes how to run a dockerized load generator or Controller on a Windows platform.

Docker is a platform that allows you to develop, ship, and run applications via a container. For details regarding Docker, see https://docs.docker.com.
Prerequisites

- Install Docker on the target machine, along with its dependencies, and set up the target machine environment as required. Currently, only the 64-bit version is supported. For installation details, see https://docs.docker.com/install/.

- Pull the Windows load generator Docker image (tech preview version) from the Docker hub, Windows Dockerized Load Generator (https://hub.docker.com/r/performancetesting/load_generator_windows/), using the following command and appropriate `<tag version number>`, for example, 12.63:

  ```bash
docker pull performancetesting/load_generator_windows:<tag version number>
  ```

- Pull the Controller Docker image (tech preview version) from the Docker hub, Windows dockerized Controller (https://hub.docker.com/r/performancetesting/host/), using the following command and appropriate `<tag version number>`, for example, 12.63:

  ```bash
docker pull performancetesting/host:<tag version number>
  ```

Run a dockerized load generator or Controller using the predefined image

Use the ready-to-use image to run a load generator or Controller on Docker for Windows.

Note: If you need customization for your container, for example, for Java or to run under a specific user, see "Run a dockerized load generator using a custom image" on the next page.

To run a dockerized load generator:

Run the load generator container using the following command:

```bash
docker run -id -p <host_port>:54345 performancetesting/load_generator_
windows:<tag version number>

Note: Check that the <host_port> on the machine is available and allows incoming requests. You will specify this port on the Controller side when connecting to this load generator.

To run a dockerized Controller:

Run the Controller container using the following command:

```
docker run -id -p <host_port1>:8731 -p <host_port2>:8086 performancetesting/host:<tag version number>
```

where <host_port1> is the port that is mapped to the Docker container for the performance testing service, and <host_port2> is the port that is mapped to the Influx database server.

Note: Check that the host ports are available and allow incoming requests.

Run a dockerized load generator using a custom image

If your environment requires customized settings for running the container, you can create a Dockerfile to build a custom image for Docker on Windows.

Examples for custom images:

- To use a specific user account for the processes under which the Vusers are running, to provide support for accessing network resources like script parameter files. After running, the container should be able to verify the user.
- To run Java protocols on Windows load generator containers.
- To define environment variables for proxy server host and port.

To run a custom dockerized load generator:

1. Create a new folder, and within it create a file named `dockerfile`. Paste the following `FROM` line into the file, using the appropriate PC version for the `<tag version number>`, and add the relevant customization lines:

```
FROM performancetesting/load_generator_windows:<tag version number>
<Customization lines>
```

For customization examples, see "Examples of customized content for Dockerfiles" below
Tip: For information on commands that can be used in Docker files, see https://docs.docker.com/engine/reference/builder/.

2. Save the Dockerfile.

3. Open a command line at the `dockerfile` folder path and run the following command, using the name you want for your custom image:

   ```
docker build -t <custom dockerfile name> .
   ```

4. Run a container for each load generator you want to use, by running the following command, or use any Docker orchestrator tool for running containers (to deploy elastic load generators, you must provide the custom image name in the Swarm orchestrator):

   ```
docker run -id -p <host_port>:54345 <custom image name>
   ```

   If the custom image in step 3 was built with a tag then include it in the command:

   ```
docker run -id -p <host_port>:54345 <custom image name>:<tag version number>
   ```

   **Note:** Check that the `<host_port>` on the machine is available and allows incoming requests. You will specify this port on the Controller side when connecting to this load generator. This is not relevant when using elastic load generators, since this is managed by the orchestrator.

Examples of customized content for Dockerfiles

**Example for Vusers under a specified user account**

The following gives an example of dockerfile content for running the Vusers under a specified user account with network access to shared locations. Replace the values between <> with credentials for a valid user account in your environment, with network access to the shared resources.

```
#escape=`
FROM performancetesting/load_generator_windows:<tag version number>
RUN c:\LG\launch_service\bin\magentservice.exe -remove
```
Example for running Java protocols

The following gives an example of dockerfile content to run Java protocols:

```
# Example:
FROM performancetesting/load_generator_windows:<tag version number>
COPY .\folder contains JDK> <target path in the container>
```

The path to the target JDK directory defined in the COPY line for the `<target path in the container>` must also be added to the Java VM runtime settings page:

```
Note: For Java 64-bit protocol testing, include the following command line in the dockerfile, in order to add the path to the bin folder for the JDK 64-bit to the machine PATH environment variable:

RUN powershell [Environment]::SetEnvironmentVariable("Path", $env:Path + ";<target JDK path in the container>\bin", [EnvironmentVariableTarget]::Machine)
```

After Running the Load Generator Containers

Add the load generators containers to your tests.

- For elastic hosts, see Set up elastic hosts on Windows or Linux container in the Performance Center Help.
- For manually configure dockerized load generators, see Add dockerized load generators to your tests in the Performance Center Help.

```
Note: This is not relevant when using orchestrators.
```

Tips and Guidelines

- Dockerized load generators, run from the predefined image, are not supported when running over a firewall.
- Use docker ps to list the containers that are running.
To stop the load generator service:

- Use `docker stop <load generator container name or ID>` if you want to reuse the same load generator.
- Use `docker rm -f <load generator container name or ID>` in order to remove the load generator container.
- To access the host network directly, use `-net=host in place of `-p <host_port>:54345`. We recommend you use this flag if the AUT generates a lot of network activity.

## Installing Additional Components

You can install additional components that provide advanced features for working with Performance Center. You install these components from the `Additional Components` directory, located in the root directory of the installation directory. The following components are available:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent for Citrix Server</strong></td>
<td>Installs an optional component on the server machine that enhances VuGen's capabilities in identifying Citrix client objects.</td>
</tr>
<tr>
<td><strong>Agent for Microsoft Terminal Server.</strong></td>
<td>Used for extended RDP protocol record-replay. This component runs on the server side, and is used to create and run enhanced RDP scripts.</td>
</tr>
</tbody>
</table>
| **Applications**                   | This folder contains the setup files for following standalone applications: Analysis, Virtual User Generator (VuGen), Load Generator, TruClient, MI Listener, and Monitors Over Firewall.  

Run the relevant application's setup program and follow the wizard's instructions. For details, see "Applications * on page 11." |
| **Assembly Crawler for Analysis API** | Installs a command-line utility to build a .NET configuration file for a LoadRunner Analysis API application. For details, refer to the Analysis API Reference. |
| **IDE Add-ins**                    | Installs add-ins for Visual Studio or Eclipse, enabling you to create NUnit or JUnit tests in your standard development environment using the LoadRunner API. |
| **PAL Data Set Creator**           | This tool enables you to create production data sets. After creating the data sets, you can upload them from PAL and use them in your reports. You can create Microsoft IIS W3C Extended Log Format, Google Analytics, and Webtrends datasets. For details, see the PAL section in the Performance Center Help. |
### Component | Description
--- | ---
**SAP Tools** | The following SAP tools are available:
- **SAPGUI Spy.** Examines the hierarchy of GUI Scripting objects, on open windows of SAPGUI Client for Windows.
- **SAPGUI Verify Scripting.** Verifies that the SAPGUI Scripting API is enabled.

**Third Parties** | Includes the source code for open source packages that are incorporated into Performance Center, and which have licenses with source distribution clauses.

**Virtual Table Server** | Virtual Table Server (VTS) is a web-based application that works with Vuser scripts. VTS offers an alternative to standard parameterization.
Two versions of VTS are available: 32-bit and 64-bit. You can install 32-bit VTS on both 32-bit and 64-bit operating systems; 64-bit VTS can be installed only on 64-bit operating systems.

**VuGen Script Converter** | Installs the VuGen Script Converter that enables converting NUnit/JUnit tests to VuGen scripts in order to run them in Performance Center.

### Deploying Performance Center on AWS

Performance Center is certified to be installed and run under Amazon Web Services (AWS), using a BYOL (Bring Your Own License) model.

Requirements for deploying Performance Center on AWS:

- All components of the cloud computing environment follow the system requirements specified in this document. For AWS requirements for ALM, see the ALM System Requirements guide available from the ALM Help Center.
- The required ports are open for communication. For the required posts, see "Communication Paths" on page 12.

**Note:**
- Cloud load generators can be provisioned using the built-in functionality of Performance Center. For details, see Manage Load Generators on the Cloud in the LoadRunner help and Provision cloud load generators in the Performance Center help. All other components must be manually installed and configured by the user.
- To improve performance, it is preferable to deploy the ALM server, Performance Center server and hosts, and the database in the same region. Consult AWS for best practices about network performance.
- Cloud load generator ports are configurable. When all the components are in the cloud, the ports to use are defined by the cloud provider (they are not based on internal IT policies).

### Upgrading to the latest Performance Center patch

Performance Center 12.61, 12.62, and 12.63 are patches that must be installed on top of Performance Center 12.60.

- **Upgrading to 12.63 from version 12.60, 12.61, or 12.62:** You can install a patch by running the installation package interactively, by performing a remote patch installation, or by installing the patch in silent mode. A Performance Center patch should be installed on the Performance Center server, hosts, and load generators.

  **Tip:** We recommend using a remote patch installation to install the patch on Performance Center hosts and load generators.

- **Upgrading from a version earlier than 12.60:** Install Performance Center 12.60 as described in "Installing and Configuring Performance Center Servers and Hosts" on page 34. The installation process detects the older version, and gives you the option to upgrade or exit the installation. Then install the 12.63 patch, as described below.

**Note:**

- Performance Center Server 12.50 and later and Performance Center hosts 12.55 and later support upgrade to 12.60 without having to uninstall the previous version.
- When upgrading from version 12.55 or earlier, if you used custom certificates in your previous installation of Performance Center, install them again when prompted for certificates during setup. Otherwise, the setup program will overwrite them using the defaults.
- Due to changes in Performance Center licensing in version 12.60, you need to replace your current license to enable working with Performance Center 12.60. To obtain and install a new license, see "Adding Performance Center Licenses" on page 46.
Before installing a patch

Review the pre-installation instructions and recommendations, and perform the following before you install the patch:

- Verify that the required major or minor version of Performance Center has been installed (see the readme).
- Verify that you have full local administrative permissions (root account for Linux systems) to install the patch on the machine.
- Check the system validity of the installed Performance Center version by running a trial test and checking system health.
- Make sure there are no active runs or jobs on the machine (if necessary close mdrv.exe, TruClientIELauncher.exe, firefox.exe, or chrome.exe).
- To minimize patch installation issues, restart the hosts using the Reboot Host option in Performance Center Administration > Management > Hosts (Hosts tab) > Maintenance. For details, see Manage Hosts in the Performance Center Help. For additional troubleshooting information, see "Troubleshooting patch installation issues" on the next page below.

Installing the patch in interactive mode

1. Run the patch installation file provided with the installation package, or available from the Micro Focus MySupport site.

<table>
<thead>
<tr>
<th>Version</th>
<th>Patch</th>
</tr>
</thead>
</table>
| 12.61   | PC_00349.exe for Performance Center server  
          PC_00351.exe for Performance Center host |
| 12.62   | PC_00350.exe for Performance Center server  
          PC_00352.exe for Performance Center host |
| 12.63   | PC_00365.exe for Performance Center server  
          PC_00367.exe for Performance Center host |

2. Follow the on screen installation and deployment instructions.
3. Update the Performance Center standalone applications with the appropriate patch.
4. After installing the patch, clear the browser cache on your client machine before accessing the application.

Note: To uninstall a patch that was initially installed from the network, you need to remove the installation file separately from each Performance Center host machine on which it was installed.
Installing the patch remotely from Performance Center Administration

For Performance Center Hosts and Standalone Load Generators, you can install the patch from Performance Center Administration.

1. To upload the relevant patch (.msp) for Performance Center Host and/or Standalone Load Generators, in Management > Hosts > Patches tab, enter the details for the patch, and click Upload.
   For details, see Upload Patches in the Performance Center Help.

2. To install the patch, in the Hosts tab, select the relevant hosts on which to install the patch, and select Maintenance > Install Patch.
   For details, see Install patches on hosts in the Performance Center Help.

Installing the patch in silent mode

You can install the patch from the command line in silent or non-interactive mode. This option is useful when installing the patch on multiple machines (for example, when working with Microsoft SMS):

```
msiexec.exe /update <full path to msp file> [/qn] [/l*v<x <full path to log file>]
```

The /qn option sets the silent mode and /l*v enables logging in verbosity mode.

Troubleshooting patch installation issues

This section provides information for troubleshooting patch installation issues.
Antivirus issues

When installing the patch, you might encounter the following error messages, which can occur as a result of your antivirus software interfering with the installation process:

- “Failed installing patch. Failed to read progress log on the host machine. Please try to re-install the patch.”
  
  This might occur because an msi is already running on the host, which can stop the installation process.

  **Resolution:** Wait at least an hour before trying to reinstall the patch.

- “Failed installing patch. (1618) Another installation is already in progress. Complete that installation before proceeding with this install.”
  
  This might occur the first time you run the Performance Center patch.

  **Resolution:** After the running installation has completed, try to reinstall the patch.

Other issues

- “Failed installing patch.”
  
  **Resolution:** Wait a short time before trying to reinstall the patch.

- “Failed installing patch. Abnormal termination. The installation process is not found.”
  
  You might encounter this message if host resources are low, or there are network connectivity issues.

  **Resolution:** Try to reinstall the patch.

Uninstalling Performance Center Server and Hosts

You can uninstall Performance Center servers and hosts using the Performance Center Setup Wizard or using the silent commands.

**Note:**

- **Performance Center 11.52 or 11.52 Patch 1:** After uninstalling Performance Center, the Performance Center installer does not remove all of the related configuration settings. Prior to installing Performance Center 12.60, make sure to remove the configuration settings. For details, see Software Self-solve knowledge base article KM01174822.

- **Performance Center 11.5x:** After uninstalling Performance Center 11.5x, there is a possibility that you will not be able to launch any program from your machine. This problem can occur on a Performance Center server or host. For more details on fixing this problem, see Software Self-solve knowledge base article KM01178049.
NV: When uninstalling Performance Center, the NV components installed during the Performance Center installation will be automatically uninstalled.

**To uninstall Performance Center components using the setup wizard:**

1. From the Windows Control Panel, open the Add/Remove Programs dialog box.
2. From the list of currently installed programs, select **Micro Focus Performance Center** (for Performance Center server) and **Micro Focus LoadRunner** (for Performance Center hosts) and click **Remove**.
3. Follow the instructions in the wizard to complete the uninstall process.

**To uninstall Performance Center components silently:**

Run the applicable command from the command line.

- **Performance Center Server:**
  ```
  msiexec.exe/uninstall "<Installation_Disk_Root_Directory>\Setup\Install\Server\PCServer.msi" /qb
  ```

- **Performance Center Host:**
  ```
  msiexec.exe/uninstall "<Installation_Disk_Root_Directory>\Setup\Install\Host\LoadRunner_x64.msi" /qb
  ```

**Uninstalling Load Generator from Linux**

You can use the Load Generator Setup Wizard to uninstall the Load Generator. For details, see the *LoadRunner Installation Guide* available from the *LoadRunner Help Center*.
Chapter 3: Post Installation Verification

This section describes how to verify that the installation of the Performance Center server and hosts was successful. The environment for this process should be a staging environment, including a Performance Center server and two to three Performance Center hosts.

Note: You can run a full validation on your Performance Center system from Performance Center Administration, in the System Health page's Check System tab. For details, see the Administration section in the Performance Center Help.

Administrator Workflow

This section describes the workflow for the Performance Center administrator.

1. **Log on to Site Administration.**
   a. Open the Web browser and type the ALM URL:
      
      http://<ALM platform server>[<:port number>]/qcbin.
      
      The ALM Options window opens.
   b. Click Site Administration, enter the user name and password of a Site Administrator, and click Login.

2. **Create a project administrator user.**
   a. In Site Administration, select the Site Users tab and click New User. The New User dialog box opens.
   b. Enter the details of the project administrator user, and click OK.
   c. Select the user, click Password, enter the password, and click OK.

3. **Create a domain.**
   a. In Site Administration, select the Site Projects tab and click Create Domain. The Create Domain dialog box opens.
   b. Enter a name for the new domain, and click OK.

4. **Create a new project.**
   In the Site Projects tab, select the domain you just created, and click Create Project. Follow the steps to create the project. When prompted:
   a. Add the project administrator user you created above to the Selected Project Administrators list.
   b. ALM (consolidated license): Select ALM Lab Extension for functional and performance testing.

5. **Assign more project administrators to the project - optional.**
a. Click the Site Projects tab.

b. In the Projects list on the left, select the project you created.

c. In the right pane, click the Project Users tab.

d. Add another user, and select Project Administrator.

6. Log onto Performance Center Administration.

a. Open your Web browser and type the Performance Center Administration URL:

   http://<Performance_Center_Server_name>/admin

   The Performance Center Administration Login window opens.

b. Enter the user name and password of a Performance Center Administrator, and click Login.

7. Verify the Performance Center configuration.

On the Performance Center Administration sidebar,

- Under Configuration, select Servers and verify that the Performance Center Server is listed.

- Under Configuration, select Licenses and verify the license details.

8. Define additional hosts for the staging environment.

For the staging environment, you should have two to three Performance Center hosts, where at least one host purpose is configured as Controller, and at least one host purpose is configured as Load Generator.

| Note: When adding hosts, fields in red marked with an asterisk (*) are mandatory. Make sure to include the operating system type, and the purpose of the host. For details, see Manage Hosts in the Performance Center Help. |

a. On the Performance Center Administration sidebar, under Maintenance, select Hosts.

b. Click the Create New Host button, and define the host details.

9. Create host pools.

a. On the Performance Center Administration sidebar, select Maintenance > Hosts, and click the Pools tab.

b. Click the Add New Pool button. The New Pool page opens, enabling you to define a new host pool.

c. Add a name and description (optional) for the host pool.

d. In the Linked Hosts grid, select the hosts to add to the pool, and click Assign. The selected hosts are added to the pool.

10. Define project settings.
a. On the Performance Center Administration sidebar, select **Maintenance > Projects**.
b. Under the **Project Name** column, click the project to display the project details.
c. In the Main Details tab, define the project's settings. In particular, set the Vuser limit, Host limit, and Concurrent run limit. Also, select the host pool you created above for the project.
Chapter 4: Performance Center Configuration Options

The Performance Center system comes with default configuration settings. These settings enable you to use Performance Center for its intended purpose. This chapter describes additional tuning and configuration to help you get the most out of your Performance Center system.

Note: Not all the procedures in this chapter are suitable for all usage scenarios. You should assess which procedures are suitable to your system's needs.

This chapter includes:

- Configuring IIS on Performance Center Machines to Use SSL ........................................... 78
- Configuring Performance Center to Support SSL ............................................................... 79
- Configure Secure Communication with LoadRunner Components with TLS (SSL) .................. 88
- Working with the Performance Center Agent ................................................................. 88
- Performance Center Remote Management Agent ......................................................... 89
- Recommended Configuration for Linux Load Generators ............................................ 90
- Recommended Change to the TEMP folder used by the Load Generator ..................... 90
- Establishing Connectivity with Oracle ........................................................................ 91
- Establishing Connectivity with Oracle using SSL ....................................................... 91
- Enabling Downloading Standalone Applications ....................................................... 93
- Enabling MS-SQL Windows Authentication .................................................................. 94
- Configuring SSL for Load Generators .......................................................................... 94
- Calculating File Repository Size .................................................................................. 97
Configuring IIS on Performance Center Machines to Use SSL

IIS (Microsoft Internet Information Server) is a prerequisite software for the Performance Center servers. You can configure the IIS Performance Center virtual directories (Performance Center server and host) to use SSL (Secure Socket Layer).

This section describes how to configure IIS Performance Center virtual directories to use SSL.

Before You Configure IIS

IIS uses port 443 to work over SSL. However, certain Performance Center components may also be configured to use this port. Therefore, you need to ensure that port 443 is available for use by IIS. Make sure to configure the Performance Center components to use a port other than 443.

Note: The Remote Management agent may be configured to use port 443.

Changing the Port on the Remote Management Agent

Using the Network and Security Manager tool, you can change the port being used by the Remote Management agent for over firewall communication. For details on the Network and Security Manager tool, see the LoadRunner Help Center.

Configuring IIS to Work Over SSL

This section describes the basic steps involved in setting up IIS on the Performance Center server machine to use SSL.

To configure IIS to use SSL on the Performance Center server machine:

1. Obtain a server certificate issued to the fully qualified domain name of your Performance Center server.
2. Configure IIS to work over with SSL. For information, see https://docs.microsoft.com/en-us/iis/manage/configuring-security/how-to-set-up-ssl-on-iis.
3. If your are using a secure connection for the internal URL of the Performance Center server, you need to establish trust to the Certificate Authority (CA) that issued your Performance Center server certificate.

Note: Internal URL is defined when the Performance Center server is configured in Performance Center Administration.

This trust must be established on the ALM server and on each Performance Center host.
To configure trust on the ALM server:

a. Obtain the certificate of the root and any intermediate Certificate Authority that issued the Performance Center server certificate.

b. On the ALM server, go to the ALM java bin. For example: C:\Program Files\Micro Focus\ALM\java\jre\bin

c. Import this certificate into the ALM java truststore by using a keytool command. For example:

```bash
..\keytool -import -trustcacerts -alias <CAname> -file <path to your CA root certificate> -keystore ..\lib\security\cacerts
```

Repeat for all other Certificate Authorities.

d. Replace the path to the file for your root certificate authority certificate.

**Note:** `changeit` is the default password to the java truststore. Replace as needed.

e. If your access is denied, run CMD as an administrator.

f. Restart ALM.

For Performance Center host, the root certificate of the CA should appear in the Microsoft Management Console under **Certificates (Local Computer) > Trusted Root Certification Authorities.**

**Configuring Performance Center to Support SSL**

The following section describes how to enable SSL to ensure secure communication on Performance Center. You can configure both the Performance Center server and host.

**Tip:** For additional information (and examples) on how to configure secure communication on the various Performance Center components, see our three-part blog series:

- Configure ALM Application Server to support SSL
- Configure Performance Center Server to support SSL
- Configure Performance Center Host to support SSL

**To configure secure communication on a Performance Center server for incoming requests from the ALM server and the Performance Center hosts:**

1. Configure the port that will be used to ensure secure communication on the Performance Center server. Note that the port used by IIS for the SSL binding is 443. However, by default,
the RemoteManagement Agent Service is using port 443. Either change the service’s port or configure IIS to use a port other than 443 for the SSL binding.

2. Update the web.config file located in the <Install path>\PCS directory. Perform the following steps:
   a. Create a backup copy of the web.config file and save it in a different folder.
   b. To update the web.config file, you can replace it with the predefined web.config-for_ssl file. See step 2d below.
   c. If you have manual changes you want to preserve in the web.config file, you can manually modify the file. See step 2e below.

2c. Edit the web.config file. Under the <system.servicemodel><services> tag, there are eight areas where the following comment appears: Uncomment to enable SSL. Uncomment the XML lines which appear thereafter, and comment the non-SSL settings as shown in the example below.

**Example: Before**

```
<endpoint binding="basicHttpBinding"
  contract="HP.PC.PCS.ILabService"><identity>
  <dns value="localhost"/></identity>
<endpoint address="mex" binding="mexHttpBinding"
  contract="IMetadataExchange"/>
<!-- Uncomment to enable SSL -->
<endpoint binding="basicHttpBinding"
  bindingConfiguration="BasicHttpBinding_TransportSecurity"
  contract="HP.PC.PCS.ILabService"><identity>
  <dns value="localhost"/></identity></endpoint>  
```

**Example: After**

```
<!---- <endpoint binding="basicHttpBinding"
  contract="HP.PC.PCS.ILabService"><identity>
  <dns value="localhost"/></identity></endpoint>  
<!-- Uncomment to enable SSL -->
<endpoint binding="basicHttpBinding"
  bindingConfiguration="BasicHttpBinding_TransportSecurity"
  contract="HP.PC.PCS.ILabService"><identity>
  <dns value="localhost"/></identity></endpoint>
```

Under the <system.servicemodel><behaviors> tag, there are seven areas where you need to change the httpGetEnabled parameter to false, and the httpsGetEnabled parameter to true.
Example: Before

```xml
<serviceMetadata httpGetEnabled="true" httpsGetEnabled="false" />
```

Example: After

```xml
<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
```

d. To replace web.config with the predefined web.config-for_ssl file, copy web.config-for_ssl from the `<install path>\conf\httpsConfigFiles` directory and place it under the `<install path>\PCS` directory.

Rename `web.config-for_ssl` to `web.config`.

3. Restart IIS.

4. If you have added the same Performance Center server previously over HTTP, restart the ALM service.

Note: If the Performance Center server was previously defined in ALM, and you have performed this step, then you can skip step 5.

5. Add the Performance Center server to ALM and define the Internal URL to connect through IIS secure port. The URL must begin with HTTPS.

To configure secure communication on a Performance Center host for incoming requests from the ALM and Performance Center servers:

1. The default port used by a Performance Center host service is 8731. To configure SSL on a host for port 8731, refer to the Microsoft Web Site: How To Configure a Port with an SSL Certificate, using the following URL: http://msdn.microsoft.com/en-us/library/ms733791.aspx.

   Below are examples of the steps described in the above link.

   a. Check that the port is not configured:

```
Example:

C:\Users\Demo>netsh http show sslcert ipport=0.0.0:8731

SSL Certificate bindings:

---------------------------
```
The system cannot find the file specified.

b. Run the netsh command:

You can use the command below (where certhash is the certificate thumbprint and the appid parameter is a GUID that can be used to identify the owning application. You can use any valid GUID. There are many tools that can generate a GUID).

**Example:**

```
C:\Users\Demo>netsh http add sslcert ipport=0.0.0.0:8731
   certhash=1b337c1f17e0f96b09f803fs0c2c7b3621baf2fbb appid={114F6E0C-EB01-4EE9-9CEF-3D1A500FD63F}
```

SSL Certificate successfully added

c. Check that the port is now configured:

**Example:**

```
C:\Users\Demo>netsh http show sslcert ipport=0.0.0.0:8731
```

SSL Certificate bindings:

```
---------------------
IP:port : 0.0.0.0:8731
Certificate Hash : 1b337c1f17e0f94b09f803ff0c2c7b7621baf2fbb
Application ID : {114f6e0c-eb01-4ee9-9cef-3d1a500fd63f}
Certificate Store Name : (null)
Verify Client Certificate Revocation : Enabled
Verify Revocation Using Cached Client Certificate Only : Disabled
Usage Check : Enabled
Revocation Freshness Time : 0
```
2. Perform the following steps to update the `LTOPSvc.exe.config` file:
   a. Create a backup copy of the `LtopSvc.exe.config` file located under the `<install path>in` directory, and save it in a different folder.
   b. To update the `LtopSvc.exe.config` file, you can replace it with the predefined `LTOPSvc.exe.config-for_ssl` file. See step 2d below.
      If you have manual changes you want to preserve in the `LTOPSvc.exe.config` file, you can manually modify the file. See step 2c below.
   c. Under the `<system.servicemodel><bindings><basicHttpBinding>` tag, there are two areas where the following comment appears: Uncomment to enable SSL. Uncomment the XML lines which appear thereafter.

**Example: Before**

```xml
<binding name="BasicHttpBinding_ILoadTestingService"
   closeTimeout="00:10:00"
   
   openTimeout="00:01:00" receiveTimeout="00:20:00"
   sendTimeout="00:10:00"

   allowCookies="false" bypassProxyOnLocal="false"
   hostNameComparisonMode="StrongWildcard"

   maxBufferSize="2147483647"
   maxBufferPoolSize="2147483647" maxReceivedMessageSize="2147483647"

   messageEncoding="Text" textEncoding="utf-8"
   transferMode="Buffered"

   useDefaultWebProxy="true">
```
<readerQuotas maxDepth="2147483647"
    maxStringLength="2147483647" maxArrayLength="2147483647"
    maxBytesPerRead="2147483647"
    maxNameTableCharCount="2147483647"/>

<!- Uncomment to enable SSL -->

<!-<security mode="Transport">
    <transport clientCredentialType="None"/>
</security>-->  

</binding>

Example: After

<binding name="BasicHttpBinding_ILoadTestingService"
    closeTimeout="00:10:00"
    openTimeout="00:01:00" receiveTimeout="00:20:00"
    sendTimeout="00:10:00"
    allowCookies="false" bypassProxyOnLocal="false"
    hostNameComparisonMode="StrongWildcard"
    maxBufferSize="2147483647"
    maxBufferPoolSize="2147483647"
    maxReceivedMessageSize="2147483647"
    messageEncoding="Text" textEncoding="utf-8"
    transferMode="Buffered"
    useDefaultWebProxy="true">

    <readerQuotas maxDepth="2147483647"
        maxStringLength="2147483647" maxArrayLength="2147483647"
        maxBytesPerRead="2147483647"
        maxNameTableCharCount="2147483647"/>

<!-- Uncomment to enable SSL -->

</binding>
<security mode="Transport">
  <transport clientCredentialType="None"/>
</security>
</binding>

Under the `<system.servicemodel><services>` tag, switch between the non-secured and secured endpoints and base addresses.

**Example: Before**

```xml
<endpoint contract="HP.PC.LTOP.Services.ILoadTestingService" address="LoadTestingService" name="basicHttp" binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_ILoadTestingService"/>

<!-- Use the first endpoint for regular communication and the second endpoint for SSL -->

<endpoint contract="IMetadataExchange" binding="mexHttpBinding" name="mex"/>

<!-- Use the first address for regular communication and the second address for SSL -->

<add baseAddress="http://localhost:8731/LTOP/LoadTestingService"/>

<!--<add baseAddress="https://localhost:8731/LTOP/LoadTestingService"/>-->
</host>
```
Example: After

```xml
<service name="HP.PC.LTOP.Services.LoadTestingService"
        behaviorConfiguration="CommonBasicHTTPBehavior">

  <endpoint contract="HP.PC.LTOP.Services.ILoadTestingService"
            address="LoadTestingService" name="basicHttp"
            binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_ILoadTestingService"/>
  <!-- Use the first endpoint for regular communication and the second endpoint for SSL -->

  <!-- <endpoint contract="IMetadataExchange"
               binding="mexHttpBinding" name="mex" /-->

  <endpoint contract="IMetadataExchange"
             binding="mexHttpsBinding" name="mex"/>

  <host>
    <baseAddresses>
      <!-- Use the first address for regular communication and the second address for SSL -->
      <!-- <add baseAddress="http://localhost:8731/LTOP/LoadTestingService"/>-->
      <add baseAddress="https://localhost:8731/LTOP/LoadTestingService"/>
    </baseAddresses>
  </host>
</service>
```

Under the
```
<system.serviceModel><behaviors><serviceBehaviors><behaviorname="CommonBasicHTTPBehavior"> tag, change the `httpGetEnabled` parameter to `false`, and the `httpsGetEnabled` parameter to `true`.```
Example: Before

```xml
<serviceMetadata httpGetEnabled="true" httpsGetEnabled="false" />
```

Example: After

```xml
<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
```

d. To replace `LTOPSvc.exe.config` with the predefined `LTOPSvc.exe.config-for_ssl` file, copy `LTOPSvc.exe.config-for_ssl` from the `<install path>\conf\httpsconfigfiles` directory and place it under the `<install path>\bin` directory.

   Rename `LTOPSvc.exe.config-for_ssl` to `LTOPSvc.exe.config`.

3. Restart the Windows service "Performance Center Load Testing Service".

   **Note:** If the "Performance Center Load Testing Service" does not start after configuring the Performance Center host to listen on HTTPS, see Software Self-solve knowledge base article KM03101264.

4. Update the Performance Center servers to ensure that the communication with the host is secure.

   Edit the `PCS.config` file, located in the `<install path>\dat` path, as follows: Change the value of the `ltopIsSecured` parameter to `true`.

   **Example: Before**

   ```xml
   <PCSSettings ltopPortNumber="8731" ltopIsSecured="false" StartRunMaxRetry="3" DataProcessorPendingTimeoutMinutes="2880"/>
   ```

   **Example: After**

   ```xml
   <PCSSettings ltopPortNumber="8731" ltopIsSecured="true" StartRunMaxRetry="3" DataProcessorPendingTimeoutMinutes="2880"/>
   ```

5. Restart IIS on the Performance Center servers.
Configure Secure Communication with LoadRunner Components with TLS (SSL)

You must update CA and TLS certificates if they were created with LoadRunner tools (Controller, MI Listener, Load Generators, Monitors Over Firewall) or they do not contain the required extension information for the CA certificate being used.

For Performance Center, in addition to these steps, you also need to update CA and TLS certificates for the Performance Center server which communicates with load generators for LAB-related operations. These certificates are located in the `<PC Server installation folder>\dat\cert` folder.

For details on how to obtain the required certificates, see Secure Communication with TLS (SSL) in the LoadRunner Help Center.

**Note:** After configuring secure communication with TLS, you need to restart the services. To do so, you can either:

- Run `LoadRunner Agent Service` and `RemoteManagement Agent Service` (for a standalone load generator), or `Performance Center Agent Service` and `RemoteManagement Agent Service` (for a Performance Center host).
- Alternatively, run the following command:
  
  `lr_agent_settings.exe -restart_agent`

Working with the Performance Center Agent

The Performance Center Agent runs on the load generators and enables communication between the Controller, Load Generators, and MI Listeners (in over firewall configurations). The agent receives instructions from the Controller to initialize, run, pause, and stop Vusers. At the same time, the agent also relays data on the status of the Vusers back to the Controller.

Running the Performance Center Agent as a Process

In some cases, running GUI Vusers on remote machines, or terminal sessions, the Performance Center Agent must run as a process.

To change the Performance Center Agent from a service to a process:

On the host machine, select **Start > Programs > Micro Focus > LoadRunner > Tools > Agent Runtime Settings Configuration**, and select **Manual log in to this machine**.

Running the Performance Center Agent as a Service

In most cases, the Performance Center Agent runs as a service.
To change the Performance Center Agent from a process to a service:

On the host machine, select **Start > Programs > Micro Focus > LoadRunner > Tools > Agent Runtime Settings Configuration**, and select **Allow virtual users to run on this machine without user login**, and enter a valid user name and password.

Configuring the Agent on Load Generator Machines

When working with protocols that use network files or Web protocol Vusers that access the Internet through a proxy server, the Load Generator agent must have network privileges. Note that the default user created by Performance Center, **System**, does not have network privileges.

By default, the agent runs as a service on the Load Generator machines. You can either run the agent as a process or you can continue running the agent as a service. To continue running it as a service, configure it to run the session using the local system account or another user account with network access privileges.

Mapping Network Drives when Running Agent as Service

For all Windows platforms, when the user is logged off, the service cannot resolve the mapping of network drives. In cases when the service cannot work with mapped network drives, use the full path to the directory, for example, `${machine-name}\directory`.

Performance Center Remote Management Agent

The Performance Center Remote Management Agent Service enables you to manage remote machines from Performance Center Administration.

The agent is hosted on a Windows-based operating system, and it is run as a service under a Local System account, which has extensive privileges. If you want to run the service with the minimal permissions required for its operation, see the section below.

Change user under which the services are running

To run the agent service with a less-privileged user, change the user under which the service is running. To do so, configure a limited user account with restricted privileges (such as a Windows service account), that allows the user to perform only the necessary actions required by the system.

When creating a limited user account for running the agent service, we recommend using a Standalone Load Generator. Otherwise, you will have to reconfigure the service to run under this user account each time the Performance Center server or host are reconfigured (since the process recreates the Remote Management Agent Service with the default Local System account privileges).
**Recommended Configuration for Linux Load Generators**

You can increase the number of file descriptors, process entries, and amount of swap space by configuring the kernel.

For details and recommendations on improving Linux Load Generator performance, see the *LoadRunner Installation Guide* available from the LoadRunner Help Center.

**Recommended Change to the TEMP folder used by the Load Generator**

This section describes how to manually change the default TEMP folder used by the load generator to store data during a test run. The TEMP folder is predefined, and is based on the load generator installation folder.

**Why change the location of the folder?**

- The TEMP folder also contains the script. Depending on the machine and the script, this path can get very long, and exceed the character limitation set by Windows.
- You want to use a different folder or drive instead of the default one.

**Note:** You cannot change the TEMP folder location if your load generator is configured over a firewall (whether the firewall is enabled or disabled).

**Before changing the TEMP folder**

Note the following before changing the TEMP folder used by the load generator:

- The change will actually be made on the Performance Center Host that is serving as a Controller. Therefore, such change would only apply to the load generators using this Controller.
- If you are using the same load generators with a new Controller, you will need to reapply this change on the new Controller.

**To change the TEMP folder:**

1. Log onto the Performance Center Host machine.
2. Verify that the `Wirun.exe` process is down.
3. Open `<LG installation folder>\config\Wlrun7.ini` in a text editor.
4. Add the line "UserRemoteTmpDir=<Custom temp location>" under the `[Host]` section.
5. Save the change.

**Establishing Connectivity with Oracle**

When working with Oracle, ensure that the Oracle client (32-bit) is installed on the same machine as the Performance Center server and that connectivity is established with the Oracle server.

The `tnsnames.ora` file located on the Performance Center server (for example: `..\oracle\product\<oracle client version>\client_1\NETWORK\ADMIN\tnsnames.ora`) must contain a TNS entry for the source and target database servers. This entry can be copied from the `tnsnames.ora` file on the Oracle server to the Oracle client machine.

For example, for the Oracle database instance, `ALMInst`, the `tnsnames.ora` file, should contain the following entry:

```
Example:

ALMInst =
    (DESCRIPTION =
    (ADDRESS_LIST =
    (ADDRESS = (PROTOCOL = TCP)(HOST = <db_host>)(PORT = 1521))
    )
    (CONNECT_DATA =
    (SERVICE_NAME = ALMInst)
    )
)
```

To test that the TNS name entry is properly configured:

1. On the Performance Center server machine, open a command prompt.
2. Type:

```
sqlplus <user/password>@<instancename>
```

where `<instancename>` is the name of the current instance.

3. Verify that you are successfully connected to the Oracle server.

**Establishing Connectivity with Oracle using SSL**

When working with Oracle, ensure that the Oracle client (32-bit) is installed on the same machine as the Performance Center server and that connectivity is established with the Oracle server.
1. In the `tnsnames.ora` file located on the Performance Center server (for example: `..\oracle\product\<oracle client version>\client_1\NETWORK\ADMIN\tnsnames.ora`), set the protocol to TCPS.

   For example, for the Oracle database instance, `ALMInst`, the `tnsnames.ora` file, should contain the following entry:

   ```
   Example:

   ALMInst =
   (DESCRIPTION =
   (ADDRESS_LIST =
   (ADDRESS = (PROTOCOL = TCPS)(HOST = <db_host>)(PORT = 1521))
   )
   (CONNECT_DATA =
   (SERVICE_NAME = ALMInst)
   )
   )
   ```

2. Add location of the Oracle wallet in the `sqlnet.ora` file. Copy `ewallet.p12` and `cwallet.sso` to the location specified in the `sqlnet.ora` file (request files from the Oracle DBA).

   For example, for the Oracle wallet, the `sqlnet.ora` file, should contain the following entry:

   ```
   Example:

   WALLET_LOCATION =
   (SOURCE =
   (METHOD = FILE)
   (METHOD_DATA =
   (DIRECTORY = <drive>:\path to directory containing the ewallet.p12 and cwallet.sso files)
   )
   )
   ```

   **To test connectivity:**

   1. On the Performance Center server machine, open a command prompt.
   2. Type:

   ```sqlplus <user/password>@<instancename>```
where `<instancetype>` is the name of the current instance.

3. Verify that you are successfully connected to the Oracle server.

### Enabling Downloading Standalone Applications

This section explains the steps necessary to enable you to download standalone applications from the Download Applications window.

**Note:** To access the Download Applications window, in Lab Management or in the ALM project, select **Tools > Download Standalone Applications**.

**To enable downloading standalone applications:**

1. Navigate to the `<Performance Center installation directory>\Additional Components` folder. This directory contains the applications' execution (.exe) files.

   **Note:** The necessary .exe files for downloading VuGen, Analysis, Standalone Load Generator, Monitor over Firewall, and MI Listener, are located in the **Applications** directory, which is contained within the **Additional Components** directory.

2. On the Performance Center server, navigate to the **Downloads** directory, which is located in `<Performance Center server installation directory>\PCWEB\Downloads`.

3. To enable downloading an application, copy the relevant execution file (.exe) from the `<Performance Center installation directory>\Additional Components` folder to the **Downloads** directory on the Performance Center server.

   **Note:** You may need to refresh the Download Applications window for the changes to take effect.

### Customizing the Download Applications Window

You can edit and customize the appearance of the Downloads Applications window. To customize the window, edit the `downloads.xml` file located in the **Downloads** directory on the Performance Center server.

The following tags in the `downloads` file control the following features on the window. Edit the tags as desired to change the appearance of the window.

- **App Name.** The name of the application.
- **Image.** Whether the application's icon appears to the left or to the right of the name.
- **FileName.** If you changed the name of the application's execution file, you must update this
section so that it matches the new name of the execution file.

- **Description.** The application's description.

### Enabling MS-SQL Windows Authentication

This section describes how to configure an MS-SQL database with Windows authentication.

**Note:** The procedure below requires you to make changes to the MS-SQL database. It is strongly recommended that you make these changes using the SQL Server Management Studio tool.

**To enable Windows authentication:**

1. Verify that the Performance Center server, ALM server, and database server, all belong to the same domain, and that there is a domain user with administrator privileges common to all the machines.
2. Change users to domain users using the System Identity Utility. For details, see the Administration section in the Performance Center Help.
4. In SQL Server Management Studio, perform the following actions:
   a. In the Object Explorer pane, expand the Security folder.
   b. Right-click Logins and select New Login.
   c. Enter the domain user in the Login name box, and make sure that Windows Authentication is selected.

**Note:** Verify that the domain user is assigned the same Server Roles as the database administrative user (td_db_admin).

5. Make sure that the relevant project is created in Site Administration with the **MS-SQL (Win Auth)** database type. For details, see the Configuring Servers and Parameters in the ALM Lab Management Guide.

### Configuring SSL for Load Generators

This section describes how to configure SSL communication to the load generators. It describes how to create and install a Certification Authority and a Client Certificate for working with SSL to secure communication to your load generators. It also describes how to enable SSL from Performance Center Administration.
How to Create and Copy Digital Certificates

1. Create a Certification Authority (CA)

   **Note:** This step describes how to create a CA using the `gen_ca_cert.exe` utility. If you are working on a Linux platform, use the `gen_ca_cert` utility instead.

   On one of your Performance Center hosts, run the `gen_ca_cert` command from the `<Performance Center host installation folder>` with at least one of the following options:
   - `country_name`
   - `organization_name`
   - `common_name`

   This process creates two files in the folder from which the utility was run: the CA Certificate (`cacert.cer`), and the CA Private Key (`capvk.cer`).

   **Note:** By default, the CA is valid for three years from when it is generated. To change the validation dates, use the `-nb_time` (beginning of validity) and/or `-na_time` (end of validity) options.

   The following example creates two files: `ca_igloo_cert.cer` and `ca_igloo_pk.cer` in the current folder:

   ```
   gen_ca_cert - country_name "North Pole" -organization_name "Igloo Makers" -common_name "ICL" -CA_cert_file_name "ca_igloo_cert.cer" -CA_pk_file_name "ca_igloo_pk.cer" -nb_time 10/10/2013 -na_time 11/11/2013
   ```

2. Install Certification Authority (CA)

   You need to install the CA on the hosts that you want to enable SSL communication including Controllers, Performance Center servers, Load Generators, and MI Listeners.

   Run the `gen_ca_cert` utility from the `<Installation root folder>` with one of the following parameters:
   - `-install <name/path of the CA certificate file>`. Replaces any previous CA list and creates a new one that includes this CA only.
   - `-install_add <name/path of the CA certificate file>`. Adds the new CA to the existing CA list.

   **Note:**
3. Create a Client Certificate

**Note:** This step describes how to create a client certificate using the `gen_cert.exe` utility. If you are working on a Linux platform, use the `gen_cert` utility instead.

On one of your Performance Center hosts, run the `gen_cert` command from the `<Performance Center host root folder>\bin` folder with at least one of the following options:

- `-country_name`
- `-organization_name`
- `-organization_unit_name`
- `-eMail`
- `-common_name`

It is important to note the following:

- The CA Certificate and the CA Private Key files are necessary for the creation of the certificate. By default, it is assumed that they are in the current folder, and are named `cacert.cer` and `capvk.cer` respectively. In any other case, use the `-CA_cert_file_name` and `-CA_pk_file_name` options to give the correct locations.
- The certificate file is created in the folder from which the utility was run. By default, the file name is `cert.cer`.

4. Install a Client Certificate

You need to install the client certificate on the hosts that you want to enable SSL including Performance Center hosts (used as Controllers), Performance Center servers, Load Generators, and MI Listeners.

Run the `gen_cert` utility from the `<Performance Center host root folder>\bin` folder with the following parameter:

```
-install <name/path of the client certificate file>
```

**Note:** Steps 3 and 4 describe how to install the same client certificate. Alternatively, you can create a new client certificate on each machine.

5. On the load generator machines, open Performance Center Agent Configuration and click **OK** to restart the agent configuration. On the MI Listener machines, open Agent Configuration and click **OK** to restart the agent configuration.
Enabling SSL Communication for Load Generators in Performance Center Administration

1. Log onto Performance Center Administration. For details, see "Logging on to Performance Center Administration" on page 43.

2. On the Performance Center Administration sidebar, under Maintenance select Hosts.

3. Under the Host Name column, click the name of an existing host or load generator over a firewall host.
   Alternatively, click New Testing Host to create a new host.

4. In the Host Details or New Host page, select Enable SSL.

Calculating File Repository Size

Performance Center requires a lot of disk space for storing script files and run results for large projects.

For details on how to calculate the amount of space you will need and for setting the frequency for deleting runs in order to clean results, see Calculate File Repository Size in the Performance Center Help.
Upgrading Previously Created Projects

To work with projects from a previous version, you will need to upgrade your projects to the latest version of Performance Center. For details, see the Application Lifecycle Management Installation and Upgrade Guide available from the ALM Help Center.

Upgrading cloud hosts

If you are using cloud hosts and are upgrading to Performance Center 12.60, you can access the 12.60 cloud images provided by Micro Focus in one of the following ways:

- **Delete your cloud account, and re-add it.** All the out-of-the-box templates are updated to the latest ones. Note that all custom templates will be lost and you will need to recreate them.

- **Manually update each template.**
  
  For out-of-the-box templates: Perform the following changes:
  
  a. Update the template name by replacing the previous version with 12.60. For example, Amazon EC2_<region>_<OS>_Load Generator 12.60_<Size>.
  b. From the list of available images, select LR-PC_Load_Generator_12.60_<OS>.

  For custom templates: If you are using the image provided by Micro Focus, from the list of available images, select LR-PC_Load_Generator_12.60_<OS>. 
Part 3: Working with Firewalls
Chapter 6: Working with Firewalls

You can set up your Performance Center system to run Vusers and monitor servers over a firewall.

This chapter includes:

- About Using Firewalls in Performance Center .......................................................... 101
- Example: Over Firewall Deployment ........................................................................ 103
- Setting Up the System to Use Firewalls: Basic Steps ............................................. 103
- Setting Up the System to Use Firewalls: Basic Steps ............................................. 103
- Setting Up the System to Use Firewalls: Basic Steps ............................................. 105
- Initial Configuration of the Over Firewall System .................................................... 106
- Specifying MI Listeners ............................................................................................ 109
About Using Firewalls in Performance Center

Working with a firewall means that you can prevent unauthorized access to or from a private network, on specific port numbers.

For example, you can specify that no access is allowed to any port from the outside world, with the exception of the mail port (25), or you can specify that no outside connection is allowed from any ports to the outside except from the mail port and WEB port (80). The port settings are configured by the system administrator.

In a regular performance test (not over a firewall), the Controller has direct access to the Performance Center agents running on remote machines. This enables the Controller to connect directly to those machines.

When running Vusers or monitoring applications over a firewall, this direct connection is blocked by the firewall. The connection cannot be established by the Controller, because it does not have permissions to open the firewall.

Performance Center solves this problem by using a communication configuration based on HTTPS or secured TCP/IP. This configuration uses the standard SSL port on the firewall (port 443). For details on HTTPS and TCP/IP system configuration, see “Setting Up Your Deployment (TCP or HTTPS)” on page 106.

A Performance Center agent is installed on Load Generators running Vusers over a firewall, and on Monitor Over Firewall machines that monitor the servers that are located over a firewall. The agent communicates with the MI Listener machine through port 443 in the firewall.

The MI Listener is a component that serves as router between the Controller and the Performance Center agent.
When the Performance Center agent connects to the MI Listener, the MI Listener keeps a listing of the connection to the agent using a symbolic name that the agent passed to it.

When the Controller connects to the MI Listener, it communicates to the MI Listener through port 50500.

The Controller uses a symbolic name for the agent, and provides the MI Listener machine's name. If there has been a connection from the agent with the same symbolic name to this MI Listener, the connection is made between the Controller and the agent. After you have a connection with the agent, you can run Vusers over firewall or monitor AUT machines behind the firewall.
Example: Over Firewall Deployment

The following diagram is a basic example of a Performance Center deployment over a firewall.

As explained in the previous section, the Performance Center agent is installed on both the Load Generator machine and the Monitor Over Firewall machine. During installation, the Performance Center agent is added as a Windows service.

The MI Listener serves as a router between:

- The agent on the Load Generator machine and the Controller, enabling the Controller to run Vusers over a firewall.
- The agent on the Monitor Over Firewall machine and the Controller, enabling the Controller to monitor the servers that are located over a firewall.

Setting Up the System to Use Firewalls: Basic Steps

Setting up the system to use firewalls involves the following stages of configuration:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation and initial configuration</td>
<td>Install the necessary components and perform initial configuration settings. For details, see &quot;Installing Over Firewall Components&quot; on page 105, and &quot;Initial Configuration of the Over Firewall System&quot; on page 106.</td>
</tr>
<tr>
<td>Stage</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enabling running Vusers over a firewall</td>
<td>When there is a firewall between the Controller and Load Generator host machines, set up the system to run Vusers over the firewall. For details, see &quot;Running Vusers Over a Firewall&quot; on page 111.</td>
</tr>
<tr>
<td>Enabling monitoring over a firewall</td>
<td>Set up your system to monitor the application under test (AUT) when there is a firewall between the Controller and the AUT. For details, see &quot;Monitoring Over a Firewall&quot; on page 116.</td>
</tr>
<tr>
<td>Checking Connectivity</td>
<td>After installing and configuring all the necessary components, check that you are able to establish a connection between the Performance Center agent, the MI Listener, and the Controller machine. For details, see &quot;Checking Connectivity&quot; on page 128.</td>
</tr>
</tbody>
</table>

The following flow chart provides a general outline of the steps that you need to perform to set up your system to work with firewalls.
Installing Over Firewall Components

To enable over firewall communication, ensure that you have installed the following Performance Center components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI Listener</td>
<td>Serves as a router between the Controller and the Performance Center agent. You install the MI Listener component on a dedicated machine. For installation instructions, see &quot;Installing Standalone Components (Windows)&quot; on page 54. For instructions on configuring the MI Listener machine, see &quot;Configuring the MI Listener&quot; on page 108.</td>
</tr>
</tbody>
</table>
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Over Firewall</td>
<td>Used to monitor the servers that are located over a firewall. You install the Monitors over Firewall component on a dedicated machine. For installation instructions, see &quot;Installing Standalone Components (Windows)&quot; on page 54. For information about configuring the Monitor Over Firewall machine, see &quot;Monitoring Over a Firewall&quot; on page 116.</td>
</tr>
</tbody>
</table>

### Initial Configuration of the Over Firewall System

After you have installed the necessary components, you are ready to configure your over firewall system.

**To perform initial configuration of your over firewall system:**

1. **Configure the system according to TCP or HTTPS.**
   
   See "Setting Up Your Deployment (TCP or HTTPS)" below.

2. **Modify the firewall settings to enable communication between the machines on either side of the firewall.**
   
   See "Configuring the Firewall to Allow Agent Access" on page 108.

3. **Configure the MI Listener.**
   
   See "Configuring the MI Listener" on page 108.

### Setting Up Your Deployment (TCP or HTTPS)

To run Vusers or monitor servers over the firewall, configure your system according to one of the following configurations. Note that these configurations contain a firewall on each LAN. There may also be configurations where there is a firewall for the Over Firewall LAN only.
**TCP Configuration**

The TCP configuration requires every Performance Center agent machine behind the customer's firewall to be allowed to open a port in the firewall for outgoing communication.

---

**HTTPS Configuration**

In the HTTPS configuration, only one machine (the proxy server) is allowed to open a port in the firewall. Therefore it is necessary to tunnel all outgoing communications through the proxy server.
Configuring the Firewall to Allow Agent Access

You modify your firewall settings to enable communication between the machines inside the firewall and machines outside the firewall.

**TCP Configuration**

The Performance Center agent attempts to establish a connection with the MI Listener using port 443, at intervals specified in the Connection Timeout field in the Agent Configuration dialog box. To enable this connection, allow an outgoing connection for HTTPS service on the firewall for port 443. The agent initiate the connection and the MI Listener communicates with the Load Generator through the connection.

**HTTPS Configuration**

The Performance Center agent attempts to establish a connection with the MI Listener, using the proxy port specified in the Proxy Port field, and at intervals specified in the Connection Timeout field in the Agent Configuration dialog box. When the connection to the proxy server is established, the proxy server connects to the MI Listener. To enable this connection, allow an outgoing connection for HTTPS service on the firewall for port 443. The proxy server can then connect to the MI Listener, and the MI Listener can connect back to the agent through the proxy server. From this point on, the agent listens to commands from the MI Listener.

**Local System Account Configuration**

If you intend to start the Performance Center agent service from the Local System account, you need to grant it permissions. If you do not provide permissions, the monitor graph will not display any data.

To grant it permissions, add a local user on the AUT machine with the same name and password as the local user on Agent machine. Add the AUT local user to the Performance Monitor Users group and restart the Agent process.

**Configuring the MI Listener**

To enable running Vusers or monitoring over a firewall, you need to install the MI Listener on one or more machines in the same LAN as the Controller outside the firewall. For installation instructions, see, "Installing Standalone Components (Windows)" on page 54.

**To configure the MI Listener:**

1. On the MI Listener server, open port 443 for the incoming traffic.
2. Select **Start > Administrative Tools > Services**, and stop **LoadRunner Agent Service**.
3. Select **Start > All Programs > Micro Focus > LoadRunner > Advanced Settings > MI Listener Configuration**, or run
4. Set each option as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Client Certificates</td>
<td>Select True to request that the client send an SSL certificate when connecting, and to authenticate the certificate. Default value: False</td>
</tr>
<tr>
<td>Private Key Password</td>
<td>The password that may be required during the SSL certificate authentication process. Default value: none</td>
</tr>
</tbody>
</table>

Click OK to save your changes or Use Defaults to use the default values.

5. Select Start > Administrative Tools > Services. To restart the LoadRunner Agent Service, select Start > All Programs > Micro Focus > LoadRunner > Advanced Settings > Agent Service.

6. Make sure that no Web Servers are running on the MI Listener or Monitor over Firewall machine. These servers use port 443 and will not allow the access required by the listening and monitoring processes.

**Specifying MI Listeners**

In Performance Center Administration, you specify one or more MI Listeners to enable running Vusers or monitoring data over a firewall.

**To add an MI Listener:**

1. On the Performance Center Administration sidebar, under Maintenance > Hosts, select MI Listeners.

2. In the MI Listeners tab, click the Add New MI Listener button. The New MI Listener page opens.
3. Enter the following details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI Listener Name</td>
<td>The host name of the MI Listener. <strong>Note:</strong> If you have two different IP addresses for the same MI Listener—one for internal communication with the Controller and a second for public communication with a Load Generator located over a firewall—enter the <strong>internal IP address</strong> here. Enter the public IP address in the <strong>Public IP</strong> field (see below).</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the MI Listener.</td>
</tr>
<tr>
<td>Public IP</td>
<td>The public IP address of the MI Listener.</td>
</tr>
<tr>
<td>Purpose</td>
<td>The role designated to the MI Listener:</td>
</tr>
<tr>
<td></td>
<td>• Diagnostics data collection over a firewall</td>
</tr>
<tr>
<td></td>
<td>• Monitoring over a firewall</td>
</tr>
<tr>
<td></td>
<td>• Running Vusers over a firewall</td>
</tr>
</tbody>
</table>

4. Click **Save**. The MI Listener is added to the grid.
Chapter 7: Running Vusers Over a Firewall

You can set up Performance Center to run Vusers over a firewall.

This chapter includes:

- Running Vusers Over a Firewall: Basic Steps ......................................................... 112
- Configuring Hosts to Run Vusers Over a Firewall ..................................................... 113
Running Vusers Over a Firewall: Basic Steps

**Installation and initial configuration**

**Running Vusers over firewall**

1. Specify MI Listener details in Performance Center Administration
2. Configure Performance Center Agent on Load Generator machine
3. Configure Load Generator Host in Performance Center Administration

**Note:** Before you configure your system to run Vusers over the firewall, ensure that you have completed the configuration steps described in "Initial Configuration of the Over Firewall System" on page 106.

**To run Vusers over a firewall:**

1. In Performance Center Administration, specify the details of the MI Listener that will be used to run Vusers over the firewall. For details, see "Specifying MI Listeners" on page 109.
2. Configure the Performance Center agent on each Load Generator machine that will run over a firewall to communicate with the MI Listener.
   
   For information on how to configure the Performance Center agent, see "Configuring the Performance Center Agent" on page 123.

   **Note:** After you configure the Performance Center agent on the Load Generator machine, you can edit the configuration settings from Performance Center Administration. For details, see Manage Hosts in the Performance Center Help.

3. In Performance Center Administration, configure the relevant Load Generator hosts to run over a firewall. For details, see "Configuring Hosts to Run Vusers Over a Firewall" on the next page.
Configuring Hosts to Run Vusers Over a Firewall

To use a Performance Center host to run Vusers over a firewall, you need to configure the relevant hosts as Load Generators in Performance Center Administration.

Part of the process of configuring a Performance Center host involves selecting a location for your host. For example, locations can be defined according to physical areas. The location also determines whether the host is located over a firewall.

Before you configure the host, you need to ensure that you have added a location over a firewall. When you are configuring a host to operate over a firewall, you select a location that is located over a firewall.

This section describes the basic steps of how to add a host as a Load Generator for running Vusers over a firewall. For detailed information about adding hosts in Performance Center, refer to the Performance Center Administration Guide.

To configure a host to run Vusers over a firewall:

1. **Add the location that is over a firewall.**
   a. In Performance Center Administration, select **Maintenance > Hosts** and click the **Locations** tab.
   b. Click **Add New Location**. The New Location dialog box opens.
   c. Enter the following details:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Name</td>
<td>The name of the host location. The name should have a logical connection to the host location.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the host location.</td>
</tr>
<tr>
<td>Over Firewall</td>
<td>Indicates whether the host location is over a firewall.</td>
</tr>
</tbody>
</table>

2. **Add the over firewall host.**
   a. On the Performance Center Administration sidebar, select **Maintenance > Hosts**.
   b. Select the **Hosts** tab, and then click **Create New Host**.
   c. In the New Host dialog box, enter the following details:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>The fully qualified domain name or IP address of the host that is assigned when creating the host.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the host.</td>
</tr>
<tr>
<td>Purpose</td>
<td>Select a purpose for the host. Note that a host over a firewall can only have a Load Generator purpose.</td>
</tr>
<tr>
<td>Source</td>
<td>Select the host's source: <strong>Local</strong> if the host exists in your testing lab, or <strong>Cloud</strong> if the host was provisioned from a cloud provider.</td>
</tr>
<tr>
<td>Priority</td>
<td>A rank assigned to the host. The higher the priority you give the host, the more likely the host will be allocated to a test. There are a number of criteria to consider when assigning priority. The main considerations are whether the host is a dedicated machine or a shared resource, and the type of hardware installed on the machine.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicate the current status of the host.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of the host that is over the firewall.</td>
</tr>
<tr>
<td>Installation</td>
<td>Select the installation type of the host. For a standalone installation of the Load Generator, select <strong>Windows Standalone LG</strong>.</td>
</tr>
<tr>
<td>MI Listener</td>
<td>Enter the IP address or host name of the MI Listener that enables data collection.</td>
</tr>
<tr>
<td>Enable SSL</td>
<td>Indicates whether the Load Generator is to communicate with the Controller via SSL (Secure Socket Layer) or not. This option is available when the Load Generator is located over a firewall.</td>
</tr>
</tbody>
</table>

**Note:** The Load Generator uses SSL to communicate with the Controller during runtime only. For non runtime functionality (including collating results), the Load Generator does not use SSL as the communication protocol.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belongs to Pools</td>
<td>The host pools to which the host is assigned.</td>
</tr>
<tr>
<td></td>
<td>Host pools enable you to control which hosts are allocated to which projects.</td>
</tr>
<tr>
<td>Host Attributes</td>
<td>Attributes of the host.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Memory, strength, installed components</td>
</tr>
</tbody>
</table>
Chapter 8: Monitoring Over a Firewall

You can set up Performance Center to monitor servers over a firewall.

This chapter includes:

• Monitoring Over a Firewall: Basic Steps ................................................................. 117
• Configuring Monitor Settings .................................................................................. 118
• Configuring the Project to Receive Monitor Over Firewall Information ......................... 121
• Editing Monitor Over Firewall Machines During a Test Run ........................................ 122
Monitoring Over a Firewall: Basic Steps

To set up your system to monitor servers over a firewall:

1. In Performance Center Administration, specify the details of the MI Listener that will be used to monitor servers over the firewall. For details, see "Specifying MI Listeners" on page 109.
2. Configure the Performance Center agent on each Monitor Over Firewall (MOFW) machine to communicate with the MI Listener.
   For details, see "Configuring the Performance Center Agent" on page 123.
3. Use the Monitor Configuration tool to configure the servers to monitor and define specific measurements that Performance Center collects for each monitored server.
   For details, see "Configuring Monitor Settings" on the next page.
4. In the relevant project, establish a connection between the tests you are running and the Monitor Over Firewall machines.
   For details, see "Configuring the Project to Receive Monitor Over Firewall Information" on page 121.

**Note:** Before you configure your system to monitor servers over a firewall, ensure that you have completed the configuration steps described in "Initial Configuration of the Over Firewall System" on page 106.
Configuring Monitor Settings

You configure the monitor settings from the Monitor Over Firewall machine, using the Monitor Configuration tool. You select the type of monitors to run and the server whose resources you want to monitor, add the measurements to monitor for each server, and specify the frequency at which the monitored measurements are to be reported.

To configure monitor settings:

1. On the Monitor Over Firewall machine, choose Start > Programs > Micro Focus > LoadRunner > Advanced Settings > Monitor Configuration. For machines without the complete Performance Center installation, choose Start > Programs > Server Monitor > Monitor Configuration. The Monitor Configuration dialog box opens.

2. Click the Add Server button. The New Monitored Server Properties dialog box opens.
3. In the **Monitored Server** box, type the name or IP address of the server whose resources you want to monitor.

   **Note:** To add several servers simultaneously, you can specify IP ranges, or separate the server names or IP ranges with commas. For example, 255.255.255.0-255.255.255.5, or server1, server2.

4. From the **Available Monitors** list, select the monitors suitable for the server being monitored.

5. Click **OK** to close the New Monitored Server Properties dialog box. The Monitored Servers list is displayed in the Monitor Configuration dialog box.

![Monitored Server Properties](image)

Default measurements are displayed for some of the monitors in the Measurements to be Monitored section. You can specify the frequency at which to report the measurements in the Measurement Properties section.

6. To add additional monitored servers to the list, repeat the steps above.

7. To edit the monitor configuration properties for a server, click the **Edit** button. The Monitored Server Properties dialog box opens enabling you to edit the monitors for the server whose resources you are monitoring.

8. Click **Apply** to save your settings.
Cloning a Monitored Server's Properties

To monitor the same properties on different server machines, you can clone a selected server's properties using the Clone Monitored Server Properties dialog box.

**To clone a monitored server's properties:**

1. Open the Monitor Configuration dialog box.
2. Right-click the server you want to clone, and select **Clone**. The Clone Monitored Server Properties dialog box opens.

   ![Clone Monitored Server Properties dialog box](image)

   In the **Monitored Server** box, type the name or IP address of the cloned server you want to create.

   **Tip:** To create several cloned servers simultaneously, you can specify IP ranges, or separate the server names or IP ranges with commas. For example, 255.255.255.0-255.255.255.5, or server1, server2.

3. The **Available Monitors** list displays the monitors that were selected for the server being cloned. Select additional suitable monitors for the cloned server.
4. Click **OK** to close the Clone Monitored Server Properties dialog box. The cloned server is displayed in the Monitored Servers list.
5. Click **Apply** to save your settings.

Adding and Removing Measurements

After you configure one or more server machines to monitor, you add measurements to monitor for each server. If Performance Center added default measurements, you can edit them as
required.

**To add a measurement to monitor:**

1. Open the Monitor Configuration dialog box.
2. Select a server from the Monitored Servers list.
3. Click the Add Measurement button. Select the appropriate monitor. A dialog box opens, enabling you to choose measurements for the monitor you selected.
4. Select the measurements that you want to monitor, and click OK.
5. Click Apply to save your settings.

**To remove a measurement from the measurements list:**

1. Select the measurement, and click the Delete button.
2. Click Apply to save your settings.

Configuring Measurement Frequency

After you have configured monitor measurements, you set a schedule for reporting each measurement.

![Measurement Properties](image)

**To configure measurement frequency:**

1. In the Monitor Configuration dialog box, under the Measurement Properties section, select the configured server measurement you want to schedule.
2. Specify the frequency at which you want Performance Center to report the measurement.
3. Click Apply to save your settings.

Configuring the Project to Receive Monitor Over Firewall Information

After you configure the monitors, you configure the project to receive Monitor Over Firewall information during performance test runs.

**Note:** The steps in the section are described in more detail in the section about monitor profiles in the Performance Center User Guide.

**To configure the project to receive Monitor Over Firewall information:**
1. Add a monitor over firewall which can be accessed by performance tests in this project.
   a. From the Performance Center navigation toolbar, click and select **Monitors** (under **Assets**).
   b. Click **New Monitor Over Firewall**.
   c. Enter a name, the machine key, and select the MI Listener with which the monitor is to connect.

2. Select the Monitor Over Firewall agent to use in a specific performance test.
   a. In the Test Plan module, select a performance test, and click **Edit Test** to open the test in the Performance Test Designer window.
   b. In the Monitors tab, select the Monitor Over Firewall agent.

**Editing Monitor Over Firewall Machines During a Test Run**

While a performance test is running, you can change the status of a Monitor Over Firewall agent or add another monitor to the test.

**To modify the Monitor Over Firewall machines:**

1. On the Test Run page, click the **Monitors** button and select **Monitors Over Firewall**. The Monitors Over Firewall dialog box opens.
2. You can view the Monitor Over Firewall agents that are monitoring the test, as well as their connection status.
   - To connect or disconnect a Monitor Over Firewall agent, click the **Connect/Disconnect** button.
   - To add a Monitor Over Firewall agent to the test, select it from the **Add Monitor Over Firewall** list.
Chapter 9: Configuring the Performance Center Agent

You can set up your Performance Center system to run Vusers and monitor servers over a firewall. As part of the process of setting up your Performance Center system to work over firewalls, you configure the Performance Center agent.

This chapter includes:

- About Configuring Performance Center Agents Over the Firewall .............................................. 124
- Configuring the Windows Performance Center Agent ................................................................. 124
- Configuring and Running the Linux Performance Center Agent ............................................ 125
- Agent Configuration Settings ........................................................................................................ 126
- Checking Connectivity ................................................................................................................ 128
About Configuring Performance Center Agents Over the Firewall

For Performance Center to work over firewalls, you need to configure the Performance Center agent on each Load Generator machine that will be running over a firewall and on each Monitor Over Firewall machine.

You configure the Performance Center agent to communicate with the MI Listener. The MI Listener serves as a router between the Performance Center agent and the Controller.

Configuring the Windows Performance Center Agent

This section describes how to configure the Performance Center Agent on Windows machines to communicate with the MI Listener.

To configure the Performance Center agent on Windows machines:

1. Select Start > Programs > Micro Focus > LoadRunner > Advanced Settings > Performance Center Agent Configuration, or run <Performance Center root>\launch_service\bin\AgentConfig.exe.

   The Agent Configuration dialog box opens.

2. Select Enable Firewall Agent.

3. Click Settings. The Agent Configuration dialog box displays a list of settings.

4. Set each option as described in "Agent Configuration Settings " on page 126. Pay careful attention to the first three settings.
5. Click **OK** to save your changes.
6. When prompted, click **OK** to restart the Performance Center agent.
7. Check the connection status between the Performance Center agent and the MI Listener.
   a. Change the Agent Runtime settings to run as a process and check the status. For details, see "Running the Performance Center Agent as a Process" on page 88.
   b. If the status is OK, revert back to running it as a service. For details, see "Running the Performance Center Agent as a Service" on page 88.

**Notes:**
- When you configure the Performance Center agent on Windows machines, the Remote Management agent is automatically configured with the same settings. The Remote Management agent enables you to manage remote machines from Performance Center Administration.
- After you have configured the Performance Center agent on the Load Generator machine, you can edit the configuration settings from Performance Center Administration. For details, see the Help Center.

## Configuring and Running the Linux Performance Center Agent

Load Generator hosts can be installed on Linux machines. This section describes how to configure and run Performance Center agents on Linux machines.

**Note:** As part of the process of configuring the Performance Center Agent on Linux machines, you also need to configure the Remote Management agent. The Remote Management agent enables you to manage remote machines from Performance Center Administration.

**To configure the Performance Center Agent on Linux machines:**

1. Activate the firewall service for the Performance Center agent:
   a. Open `<Performance Center root folder>/dat/br_Inch_server.cfg` in a text editor.
   b. In the Firewall section, set `FireWallServiceActive` to 1 and save your changes.
2. Activate the firewall service for the Remote Management agent:
   b. In the Firewall section, set `FireWallServiceActive` to 1 and save your changes.
3. Run `agent_config` from the `<Performance Center root folder>/bin` directory and enter the
agent configuration settings (see "Agent Configuration Settings" below).

Note: When you set the agent configuration settings, they are applied to both the Performance Center and Remote Management agents.

4. Restart the Performance Center agent for the configuration changes to take effect.
5. Restart the Remote Management agent for the configuration changes to take effect.
   a. To stop the Remote Management agent, run the following command from the 
      `<Performance Center root folder>/al_agent/bin` directory:

        al_daemon_setup -remove

   b. To start the Remote Management agent, run the following command from the 
      `<Performance Center root folder>/al_agent/bin` directory:

        al_daemon_setup -install

### Agent Configuration Settings

The following table provides an explanation of the agent configuration settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI Listener name</td>
<td>none</td>
<td>The host name, fully qualified domain name, or IP address of the MI Listener.</td>
</tr>
</tbody>
</table>
| Local Machine Key     | none          | A symbolic string identifier used to establish a unique connection between the Controller host and the agent machine, via the MI Listener machine. When configuring a Monitor Over Firewall agent, you can enter any logical name, using lowercase letters only. When configuring the agent on a load generator to run Vusers over a firewall, you must use the format `hostname_locationname` where:  
  - `hostname` is the name of the host as found in Performance Center Administration's Hosts page.  
  - `locationname` is the name of the host location as found in Performance Center Administration's Host Locations page. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Timeout</strong></td>
<td>20 seconds</td>
<td>The length of time you want the agent to wait before retrying to connect to the MI Listener machine. If zero, the connection is kept open from the time the agent is run.</td>
</tr>
<tr>
<td><strong>MI Listener User Name</strong></td>
<td>none</td>
<td>The user name needed to connect to the MI Listener machine.</td>
</tr>
<tr>
<td><strong>MI Listener Password</strong></td>
<td>none</td>
<td>The password needed to connect to the MI Listener machine.</td>
</tr>
<tr>
<td><strong>Server Domain</strong></td>
<td>none</td>
<td>The domain name needed to connect to the MI Listener machine. This field is required only if NTLM is used.</td>
</tr>
<tr>
<td><strong>Connection Type</strong></td>
<td>TCP</td>
<td>Select either <strong>TCP</strong> or <strong>HTTP</strong>, depending on the configuration you are using.</td>
</tr>
<tr>
<td><strong>Connection Type - HTTP Proxy Name</strong></td>
<td>none</td>
<td>The name of the proxy server. This field is mandatory if the <strong>Connection Type</strong> setting is <strong>HTTP</strong>.</td>
</tr>
<tr>
<td><strong>Connection Type - HTTP Proxy Port</strong></td>
<td>none</td>
<td>The proxy server connection port. This field is mandatory if the <strong>Connection Type</strong> setting is <strong>HTTP</strong>.</td>
</tr>
<tr>
<td><strong>Connection Type - HTTP Proxy User Name</strong></td>
<td>none</td>
<td>The user name of a user with connection rights to the proxy server.</td>
</tr>
<tr>
<td><strong>Connection Type - HTTP Proxy Password</strong></td>
<td>none</td>
<td>The password of the user with connection rights to the proxy server.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection Type - HTTP Proxy Domain</td>
<td>none</td>
<td>The user's domain if defined in the proxy server configuration. This option is required only if NTLM is used.</td>
</tr>
<tr>
<td>Use Secure Connection (SSL)</td>
<td>disabled</td>
<td>Enable to connect using the Secure Sockets Layer protocol.</td>
</tr>
<tr>
<td>Use Secure Connection (SSL) - Check Server Certificates</td>
<td>none</td>
<td>Authenticates the SSL certificates that are sent by the server. Select Medium to verify that the server certificate is signed by a trusted Certification Authority. Select High to verify that the sender IP matches the certificate information. This setting is available only if Use Secure Connection is set to True.</td>
</tr>
<tr>
<td>Use Secure Connection (SSL) - Private Key Password</td>
<td>none</td>
<td>The password that might be required during the SSL certificate authentication process. This option is relevant only if the Client Certificate Owner option is enabled.</td>
</tr>
</tbody>
</table>

**Checking Connectivity**

To run Vusers or monitor servers over a firewall, you must be able to establish a connection between the Performance Center agent, MI Listener, and the Controller machine.

If you encounter connectivity problems after installing and configuring all the necessary components, check the table below for troubleshooting tips.
### Check

**To check that the Firewall service was activated on the agent machine:**

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows Installation:</strong></td>
</tr>
<tr>
<td>a. Change the Agent Runtime settings to run as a process and check the status. For details, see &quot;Running the Performance Center Agent as a Process&quot; on page 88.</td>
</tr>
<tr>
<td>b. If the status is OK, revert back to running it as a service. For details, see &quot;Running the Performance Center Agent as a Service&quot; on page 88.</td>
</tr>
<tr>
<td>Otherwise, you need to reconfigure the Performance Center Agent on your Windows machine. For details, see &quot;Configuring the Windows Performance Center Agent&quot; on page 124.</td>
</tr>
<tr>
<td><strong>Linux Installation:</strong></td>
</tr>
<tr>
<td>In the temporary directory of the Performance Center Agent machine, locate the <code>&lt;local_machine_key&gt;_connected_to_MI_Listener</code> file. If the file is missing, this indicates that the <code>FirewallServiceActive=1</code> is not set in the [FireWall] section of the Agent Settings. For details, see &quot;Configuring and Running the Linux Performance Center Agent&quot; on page 125.</td>
</tr>
</tbody>
</table>

**To check that port 443 is open:**

| On the agent machine, open a command prompt window, and type the following: |
| telnet `<MI_Listener_IP>` 443. |
| Example: telnet 111.111.111.111 443 |
| If port 443 is open, a new Telnet window opens. If port 443 is not open, contact your network administrator. |

**To check that port 443 is available:**

<p>| If a web server is running on the MI Listener or Monitor Over Firewall machine, port 443 does not allow the access required by the listening and monitoring processes. Contact your network administrator to change the web server port. |</p>
<table>
<thead>
<tr>
<th><strong>Check</strong></th>
<th><strong>Solution</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>To check connectivity between the agent and the MI Listener, when running the Performance Center Agent as a service:</td>
<td>When running the Performance Center Agent as a service, do the following:</td>
</tr>
<tr>
<td>![MI Listener] ![Firewall] ![Load Generator]</td>
<td>• Check that port 443 is open. See <em>To check that port 443 is open:</em> on the previous page.</td>
</tr>
<tr>
<td>![Firewall] ![Load Generator]</td>
<td>• Check that the Agent Settings and Agent Configuration are correctly set. For details, see &quot;About Configuring Performance Center Agents Over the Firewall&quot; on page 124.</td>
</tr>
<tr>
<td>![Firewall] ![Load Generator]</td>
<td>• Run the agent as a process by launching <code>&lt;Installation&gt;\Launch_service\bin\magentproc.exe</code>. If you are successful, this indicates an authentication issue with the Performance Center Agent Service. Browse to the <strong>Administrative Tools &gt; Services &gt; Performance Center Agent Service</strong> and change the properties of this service to System User Account, or provide the username and password of a user who has administrative privileges on this machine.</td>
</tr>
</tbody>
</table>
Part 4: Troubleshooting
Chapter 10: Troubleshooting Installation Issues

This chapter provides troubleshooting for issues that arise when installing Performance Center components and during initial configuration.

This chapter includes:

- Unable to Launch any Program after Uninstalling Performance Center 11.5X ........................................... 133
- Unable to Load Windows 8 Explorer Shell After Installing Performance Center Host ........................................ 133
- Host Silent Installation Stops After Installing .NET Framework 4.6.2 ................................................................. 133
- When Starting the Installation an Integration Error Occurs .................................................................................. 134
- Error During Installation of Prerequisite WSE 2.0 SP3 or WSE 3.0 ....................................................................... 135
- Cannot Connect to Performance Center Server or Host ......................................................................................... 135
- Installation Hangs When Registering Modules ....................................................................................................... 136
- Performance Center Cannot be Added to ALM Due to Mismatch in Communication Security Passphrase .......... 136
- Performance Center Server Cannot be Added to Lab Management: HostNotFound Error ............................... 137
- Performance Center Server Cannot be Added to Lab Management: Change Machine Identity Fails ....................... 138
- Working with Performance Center when Windows Firewall is Enabled ................................................................. 138
- Uninstall of Performance Center Failed or Has Frozen ............................................................................................ 139
- Cannot Log in to Performance Center via the Client Machine: JavaScript Error ............................................... 140
- When Starting a Test Run, the Host is Added, but the Initializing Run Page Does Not Load .............................. 141
- Cannot Run Performance Center Component Installation from Network Drive ...................................................... 141
- Unable to Install Performance Center Components from the Installation Directory ........................................... 142
- Installing One of the Performance Center Components Cannot Use Default Port: Port Already in Use .............. 143
- Unable to Use Non-Default Ports in Microsoft SQL .................................................................................................. 145
- Test Fails to Start Error Message ............................................................................................................................ 146
- Unable to View Topology Monitors Online .............................................................................................................. 146
- Adding Server/Host to Lab Project: The Change Machine Identity Fails ............................................................... 147
- Performance Center Server/Host Configuration Fails: The Process is in Use By Another Process .................. 147
- Performance Center Configuration Fails: Action Not Authorized Error .............................................................. 147
- Performance Center Configuration Host Failed starting 'Performance Center Data Service' ............................ 148
- When Adding Performance Center Server to ALM: Fails to Ping URL ................................................................. 148
- Configure Performance Center to Work with Secure Cookies over a Secure Connection ............................... 149
- Unable to log on to the Database Server .................................................................................................................. 150
- Incorrect time range displayed in online graph ....................................................................................................... 150
Unable to Launch any Program after Uninstalling Performance Center 11.5X

Problem Description

After uninstalling Performance Center 11.5X, users are unable to launch any program from their machine. This problem may occur on the Performance Center servers or hosts.

Troubleshooting

See Software Self-solve knowledge base article KM01178049.

Unable to Load Windows 8 Explorer Shell After Installing Performance Center Host

Problem Description

After installing Performance Center host on Windows 8 and rebooting the machine, the windows explorer shell fails to load.

Troubleshooting

UAC is enabled on your machine. To disable, perform the following steps:

2. To open the registry editor, type Regedit in the Run dialog box.
3. Disable UAC and restart your machine. For details on how to disable UAC, see: http://gallery.technet.microsoft.com/Registry-Key-to-Disable-UAC-45d0df25.

Host Silent Installation Stops After Installing .NET Framework 4.6.2

Problem Description

Running the Host installation in silent mode using setup_host.exe /s fails to complete the installation. The installation process stops after installing .NET Framework 4.6.2.

Troubleshooting

.NET Framework 4.6.2 replaces the .NET Framework 4.0 files. If there are any applications that are using the .NET Framework 4.0 files and are running during the installation of .NET
Framework 4.6.2, you may need to restart your machine. If you are prompted to restart the machine, restart it before continuing the installation. For details, see: http://msdn.microsoft.com/en-us/library/hh527997%28v=vs.110%29.aspx.

**When Starting the Installation an Integration Error Occurs**

**Problem Description**

When starting the installation an error indicates that QC connectivity must be uninstalled before the installation can continue.

Example of error:

![Error Message](image)

Most likely the machine you are installing on used to host Unified Functional Testing (UFT), which installs QC Connectivity for backwards compatibility with previous Quality Center versions.

**Troubleshooting**

1. Open the command line and execute the following:
   
   `msiexec /x {EB221B44-30B0-424D-88A6-E7C42DFCC72C} /q`

2. Rerun the Performance Center installation.
Error During Installation of Prerequisite WSE 2.0 SP3 or WSE 3.0

Problem Description

When installing WSE 2.0 SP3 or WSE 3.0 on a machine where .NET 3.5 is not enabled, the following error occurs:

Troubleshooting

Enable .NET 3.5 and restart the installation.

Cannot Connect to Performance Center Server or Host

Problem Description

Connection issues may cause different errors including:

- Inability to add Performance Center server to the system
- Inability to add Performance Center host to the system
- Ability to install the Performance Center server, but inability to view Performance Center web pages (for example: License page, Performance Test Designer, and so on)

Troubleshooting

1. Make sure a network connection is available from one machine to the other. To check connectivity, make sure you can ping from one machine to another, or alternatively use telnet <port number>.
2. Verify that the required services are running:
   - Performance Center host: Verify that the Performance Center Load Testing Service is started.
• Performance Center server:
  i. Verify that IIS is running on the Performance Center server.
  ii. Open the IIS manager tool and verify that the IIS Web site hosting the Performance Center virtual directories is running.
  iii. Verify that the Performance Center application pools ('PCQCWSAppPool', 'PCAdminAppPool' and 'LoadTestAppPool') are running

Installation Hangs When Registering Modules

Problem Description

Both the installation and the MSI user interface hang at registering modules. This problem occurs because MSI creates a separate process for each registration action and then waits for each process to end.

Troubleshooting

Open task manager and sort the processes by name. Locate the msiexec processes that are running with the user name system. Terminate the msiexec process that is consuming the highest CPU.

Performance Center Cannot be Added to ALM Due to Mismatch in Communication Security Passphrase

Problem Description

The Communication Security passphrase on the Performance Center server/host and the ALM server do not match. The two products cannot communicate.

Troubleshooting

This can occur if an incorrect Communication Security passphrase was provided during the initial configuration of Performance Center, or if the passphrase on the ALM server was changed.

To resolve this issue, update the Communication Security passphrase on the ALM server and on the Performance Center server/host.

To update the Communication Security passphrase on the ALM server:

1. Log in to Site Administration.
2. In the Site Configuration tab, update the COMMUNICATION_SECURITY_PASSPHRASE parameter.
To update the Communication Security passphrase on the Performance Center server/host:

- **Option 1:** Update the communication security passphrase from the Performance Center Configuration Wizard:
  a. From the Performance Center server:
     Choose **Start > All Programs > Micro Focus > Performance Center Server > Tools > Server Configuration Wizard.**
  
     From the Performance Center host:
     Choose **Start > All Programs > Micro Focus > LoadRunner > Tools > Host Configuration Wizard.**
  
  c. Click **Next** on all of the subsequent wizard pages and **Finish** to close the wizard.

- **Option 2:** Update the communication security passphrase directly on each Performance Center machine:
  - **Performance Center server:** On the Performance Center server, navigate to the `PCS.config` file as follows: `<Performance Center Server path>\dat\PCS.config`. Under the `<appSettings>` tag, the value appears by the `LW_CRYPTO_INIT_STRING` key.
  
  - **Performance Center host:** On the host, navigate to the `LTS.config` file as follows: `<Performance Center Host path>\dat\LTS.config`. Under the `<appSettings>` tag, the value appears by the `LW_CRYPTO_INIT_STRING` key.

Performance Center Server Cannot be Added to Lab Management: HostNotFoundException

**Problem Description**

When adding a Performance Center server, the ALM system performs a name lookup operation. At times, the system changes the IP address or the short DNS name into a full DNS name. When this situation occurs, the system fails to add the server because the name is incorrect.

**Troubleshooting**

Validate that the Performance Center server URL is correct. Make sure that the server is up and that it can be reached from the ALM server.

If the problem persists, add the fully qualified name of the Performance Center server to the Host file (typically under `c:\Windows\System32\drivers\etc`) on ALM and the Performance Center server.
Performance Center Server Cannot be Added to Lab Management: Change Machine Identity Fails

Problem Description

When adding a Performance Center server to Lab Management, the "Change Machine Identity failed" error occurs.

When this error occurs, the IIS configuration is trying to access registry keys that no longer exist. (The log file displays the following error: "Illegal operation attempted on a registry key that has been marked for deletion.").

Troubleshooting

Reset the IIS. If the problem persists, restart the Performance Center server machine.

Working with Performance Center when Windows Firewall is Enabled

Problem Description

To work with Performance Center, we recommend that you disable the Windows Firewall on all host machines. To enable Performance Center to work with the Windows Firewall enabled, the Windows Firewall must be reconfigured.

Troubleshooting

The Windows Firewall must be configured to allow inbound and outbound communication on specific ports used by Performance Center.

The following configurations are required for all Performance Center machines in the system (servers and hosts), except for SiteScope and Diagnostics.

**Performance Center server:**

<table>
<thead>
<tr>
<th>Process / Service</th>
<th>Direction</th>
<th>Protocol</th>
<th>Local Port</th>
<th>Remote Port</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datacollectionagent.exe</td>
<td>Inbound</td>
<td>TCP</td>
<td>3333</td>
<td>Any</td>
<td>&lt;PCS install dir&gt;\bin \datacollectionagent.exe</td>
</tr>
<tr>
<td>World Wide Web Services (HTTP Traffic-In)</td>
<td>Inbound</td>
<td>TCP</td>
<td>80</td>
<td>Any</td>
<td>Service</td>
</tr>
</tbody>
</table>
### Uninstall of Performance Center Failed or Has Frozen

#### Problem Description

This error may present itself in various ways:

- Uninstall of Performance Center did not complete successfully.
- Uninstall of Performance Center is taking a long time and seems to have frozen.
- When trying to uninstall Performance Center again, Performance Center is not found in Add/Remove Programs.
Troubleshooting

- Reboot the machine and uninstall again (unless Performance Center no longer appears in Add/Remove Programs).
- Alternatively, you can:
  a. Open a command prompt and run:
     
     `<Host installation path>in\HP.PC.PCS.Configurator.exe
     /CFG:.\dat\setup\lts\xml\Configurator.xml /G:Uninstall`
  b. Delete Performance Center Host from Start menu > Programs > Micro Focus.
  c. Delete the product from the MSI manager using the Windows Installer CleanUp Utility (http://www.windows-installer-cleanup-utility.com/).

Cannot Log in to Performance Center via the Client Machine: JavaScript Error

Problem Description

Login to Performance Center fails, and the following error is displayed:

_JavaScript is not installed or is disabled in your browser._

Troubleshooting

This problem is related to running JavaScript in your browser.

To resolve this issue:

1. In Internet Explorer, select **Tools > Internet options >Security.**
2. Select **Internet zone.**
3. Click **Custom Level.**
4. Make sure that **Active Scripting** is enabled.
5. Enable the following items under **ActiveX controls and Plug-ins:**
   - **Automatic prompting for ActiveX controls**
   - **Binary and script behaviors**
   - **Run ActiveX controls and plugins**
   - **Script ActiveX controls marked safe for scripting**
When Starting a Test Run, the Host is Added, but the Initializing Run Page Does Not Load

Problem Description

When starting a test run, the host is added, but the Initializing Run page does not load.

Troubleshooting

The client machine needs to have access to the machine. For example, if the Administrator inserted the machine name without the domain, you might need to add the IP address and machine name to the host file (C:\WINDOWS\system32\drivers\etc\hosts) on the client machine.

Cannot Run Performance Center Component Installation from Network Drive

Problem Description

Cannot run the setup (Performance Center server or host) when attempting to run it from a network drive.

Troubleshooting

To run setup.exe from a network location, you need to add the network server location to your Trusted Sites, and then run setup.exe again.

To add the network server to your Trusted Sites in Internet Explorer:

1. Open Tools > Internet Options.
2. Select the Security tab and click Trusted Sites.
3. Click **Sites**.

4. In the Trusted Sites dialog box, add the location of the network server where the Performance Center component setup file is located, to the list of trusted sites.

**Unable to Install Performance Center Components from the Installation Directory**

**Problem Description**

Nothing happens when clicking the installation option from the Performance Center installation directory.

**Troubleshooting**

1. Make sure the user running the installation has sufficient permissions to launch executable files.

2. Restart the machine and try again.
Installing One of the Performance Center Components Cannot Use Default Port: Port Already in Use

Problem Description

The installation cannot use a default port because it is already in use.

Troubleshooting

If the installation cannot use a default port because it is already in use, change the port as per the instructions in the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>How to change the port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Center Server IIS</td>
<td>To change this port, see <a href="http://support.microsoft.com/kb/149605">http://support.microsoft.com/kb/149605</a>.</td>
</tr>
<tr>
<td>Performance Center host</td>
<td>To change port 8731 to a different port:</td>
</tr>
<tr>
<td></td>
<td>1. On each Performance Center host, open LTOPSvc.exe.config (located in &lt;Host Installation directory&gt;\bin) and change all four occurrences of 8731 to a new port number. Restart the Performance Center Load Testing Service.</td>
</tr>
<tr>
<td></td>
<td>2. On the Performance Center server, open pcs.config (located in &lt;Performance Center server installation directory&gt;\dat), Under PCSSettings, change ltopPortNumber to the new port number.</td>
</tr>
<tr>
<td>Component</td>
<td>How to change the port</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MI Listener</td>
<td>To change port 443 to a different port, perform the following steps on the following machines:</td>
</tr>
<tr>
<td></td>
<td>1. Controller machine (if used as MI Listener)</td>
</tr>
<tr>
<td></td>
<td>2. Load Generator machine</td>
</tr>
<tr>
<td></td>
<td>3. MI Listener</td>
</tr>
<tr>
<td></td>
<td>To change port 443:</td>
</tr>
<tr>
<td></td>
<td>1. Open <code>&lt;Component installation directory&gt;\launch_service\dat\mdrv.dat</code> and locate the <code>[launcher]</code> section.</td>
</tr>
<tr>
<td></td>
<td>2. Add <code>OFWPort=&lt;port&gt;</code>, where <code>&lt;port&gt;</code> is the new port number.</td>
</tr>
<tr>
<td></td>
<td>3. Go to <code>&lt;Component installation directory&gt;\launch_service\dat\channel_configure.dat</code> and locate the <code>[General]</code> section.</td>
</tr>
<tr>
<td></td>
<td>4. Add <code>OFWPort=&lt;port&gt;</code>, where <code>&lt;port&gt;</code> is the new port number.</td>
</tr>
<tr>
<td></td>
<td>5. Restart the agent.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> There is no support for changing port 50500.</td>
</tr>
<tr>
<td>LoadRunner/ Performance Center Agent</td>
<td>Changing the port for a Controller machine:</td>
</tr>
<tr>
<td></td>
<td>1. Stop 'Performance Center Agent Service'.</td>
</tr>
<tr>
<td></td>
<td>2. Open for edit the file: <code>&lt;Install folder\dat\merc_agent.cfg</code></td>
</tr>
<tr>
<td></td>
<td>3. Under the [Attributes] section, add the line:</td>
</tr>
<tr>
<td></td>
<td>&quot;AgentPort=&lt;New Port Value&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>4. Restart the service.</td>
</tr>
<tr>
<td></td>
<td>Changing the port for a Load Generator machine:</td>
</tr>
<tr>
<td></td>
<td>1. Stop 'Performance Center Agent Service' (can also be called 'Load Runner Agent Service').</td>
</tr>
<tr>
<td></td>
<td>2. Open for edit the file: <code>&lt;Install folder\launch_service\dat\merc_agent.cfg</code></td>
</tr>
<tr>
<td></td>
<td>3. Under the [Attributes] section, add the line:</td>
</tr>
<tr>
<td></td>
<td>&quot;AgentPort=&lt;New Port Value&gt;&quot;</td>
</tr>
<tr>
<td></td>
<td>4. Restart the service.</td>
</tr>
<tr>
<td>Component</td>
<td>How to change the port</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Autolab Agent (RemoteManagementAgent)</td>
<td>This service is used to perform administration tasks on all Performance Center machines. By default, Autolab Agent is using port 54245. The port number can be changed. However, the new value must be configured on each machine (server, host, Load Generator). To change the port: 1. Stop 'RemoteManagementAgent'. 2. Open <code>&lt;Install folder&gt;\launch_service\al_agent\dat\merc_agent.cfg</code> 3. Under the [Attributes] section, add the line: &quot;AgentPort=&lt;New Port Value&gt;&quot; 4. Restart the service.</td>
</tr>
<tr>
<td>SiteScope (Topology)</td>
<td>In Performance Center, change the port of the Topology entity to the same port as that defined during the SiteScope configuration.</td>
</tr>
<tr>
<td>SiteScope (Topology) - SSL</td>
<td>In Performance Center, change the port of the Topology entity to the same port as that defined during the SiteScope configuration.</td>
</tr>
<tr>
<td>SiteScope (Monitor Profiles)</td>
<td>In Performance Center, change the port of the Monitor Profile entity to the same port as that defined during the SiteScope configuration.</td>
</tr>
<tr>
<td>Diagnostics Server</td>
<td>In Lab Management, change the port of the Diagnostics Server entity to the same port as that defined during the Diagnostics Server configuration.</td>
</tr>
<tr>
<td>Diagnostics Server - SSL</td>
<td>In Lab Management, change the port of the Diagnostics Server entity to the same port as that defined during the Diagnostics Server configuration.</td>
</tr>
</tbody>
</table>

**Unable to Use Non-Default Ports in Microsoft SQL**

**Problem Description**

Performance Center does not work on non-default ports in Microsoft SQL.
Troubleshooting

The Microsoft SQL instance must use a static port. The correct port must be defined in the connection string.

Test Fails to Start Error Message

Problem Description

An error message is not issued when a performance test fails to start.

Troubleshooting

This problem is possibly caused by the configuration process. Validate the following:

- The Performance Center LoadTesting Service in running on the host machine under the system account.
- The PC user (IUSR_METRO) exists.
- In the wlrn7.ini, under the %systemroot% folder, make sure that IsOrchid and IsOrchid10 are both set to 1. For details, see Software Self-solve knowledge base article KM1098097.

Unable to View Topology Monitors Online

Problem Description

When running a performance test that contains topology, the topology monitors data is not shown. You may get the following error when clicking the topology tab view: This node does not have a monitor.

Troubleshooting

1. On the Host machine, validate that EnableInUi is set to 1 in <install folder> dat\online_grahs\online_resource_graphs.rmd
2. In Sitescope, set the monitor frequency value (by default it is set to 10 minutes). Make sure it is set for less than 10 seconds.
Adding Server/Host to Lab Project: The Change Machine Identity Fails

Problem Description

When adding a Performance Center server or host to Lab Management, the following is displayed: "Change machine identity failed" or "Change machine identity failed. Reason: No such interface supported".

Troubleshooting

1. The Windows operating system is unstable. It is preventing Performance Center from updating user details.
2. Reboot your machine.

Performance Center Server/Host Configuration Fails: The Process is in Use By Another Process

Problem Description

After running the Performance Center Server Configuration wizard, the following error is displayed in the log file:

"The process cannot access the file 'C:\Windows\Microsoft.NET\Framework\v4.0.30319\config\machine.config' because it is being used by another process."

This problem occurs when the configuration updates the .NET machine.config file while it is in use by another process (for example, IIS). When the file is in use, the update fails.

Troubleshooting

Restart the machine and start the Performance Center Server Configuration wizard.

Performance Center Configuration Fails: Action Not Authorized Error

Problem Description

Performance Center configuration fails with an Action not authorized message.
Troubleshooting

Ensure that the ALM internal URL and the Performance Center server internal URL are correct.

Performance Center Configuration Host Failed starting 'Performance Center Data Service'

Problem Description

After running the Performance Center Host Configuration wizard, the following error is displayed in the log file: "Failed starting service 'Performance Center Data Service"

This problem occurs if the influxdb.exe process and the Performance Center Host Configuration wizard are running at the same time.

Troubleshooting

Make sure the influxdb.exe process is not running before you run the Performance Center Host Configuration wizard.

When Adding Performance Center Server to ALM: Fails to Ping URL

Problem Description

When adding a Performance Center server to Lab Management, a "Failed to ping URL" error occurs. This problem occurs when the Performance Center server is unreachable.

Troubleshooting

1. Verify that the Performance Center server is running and that you can ping to it from the ALM server.
2. Verify that IIS is running on the Performance Center server.
3. Open the IIS manager tool and verify that the IIS Web site hosting the Performance Center virtual directories is running.
4. Verify that the Performance Center application pools ('PCQCWSAppPool' and 'LoadTestAppPool') are running.
5. From the Performance Center server, open Internet Explorer and verify that following URL can be accessed: http://localhost/pcs/LabService.svc?wsdl
   A page with details about the web service should open.
6. If you manage to complete steps 1 to 5 successfully:
a. From ALM, open Internet Explorer and enter the above URL. Replace the value `localhost` twice, once with the fully qualified name of the Performance Center server, and once with the IP address.

b. If the above step works, try to re-add the Performance Center server to ALM. Use the fully qualified name or IP address.

If the above step fails, there is probably a problem with the network and/or communication between ALM and Performance Center. Contact your network administrator for assistance.

7. If you are unable to complete steps 1 - 5 successfully:
   a. Open the Performance Center server.
   b. Stop the IIS on the Performance Center server.
   c. Open the cmd box, and enter `netstat -ano | findstr :443`
   d. You will see the service ID number that uses port 443.
   e. Select `Windows Task Manager > Services` tab.
   f. Stop the service using the service ID number.
   g. Repeat steps c to f, for port used by the IIS's web site hosting the Performance Center server virtual directories (typically port 80).
   h. Start IIS and verify that the web site hosting the Performance Center server (typically 'Default Web Site') is running.
   i. In Lab Management, add the Performance Center server.

**Configure Performance Center to Work with Secure Cookies over a Secure Connection**

**Problem Description**

By default, the Performance Center environment works with a cookie over both HTTP and HTTPS. For requests over HTTPS only, you need to configure Performance Center and Performance Center Administration to secure the cookie.

**Troubleshooting**

**Setting secure cookies on My Performance Center web pages**

1. Log onto the Performance Center server machine.
2. Open the `<Installation folder>\PCWEB\web.config` file for editing.
3. Search for ‘requireSSL’ in the file (there should be two occurrences), and set the `requireSSL` attribute to `true`. 
4. Save the file.
5. Repeat steps 1-4 for each Performance Center server in the same environment.

Setting secure cookies on Performance Center Administration web pages

1. Log onto the Performance Center server machine.
2. Open the `<Installation folder>\PCWEB_ADMIN\web.config` file for editing.
3. Search for the section 'httpCookies'.
   - If it exists, set the value of the `requireSSL` attribute to `true`.
   - If the section does not exist, add the following element under the `<system.web>` XML element:

   `<httpCookies httpOnlyCookies="true" requireSSL="true" />

4. Save the file.
5. Repeat steps 1-4 for each Performance Center server in the same environment.

Unable to log on to the Database Server

Problem Description

You receive the following error message: Problem encountered when application tried to connect to database.

Troubleshooting

Verify that the database server host name, type, username, and password are correct. Consult your database administrator if you are unsure.

Incorrect time range displayed in online graph

Problem Description

Changing the time zone on the Performance Center Server, ALM, or any external analysis database, results in the incorrect time range being displayed when running a performance test in the online graph.

Troubleshooting

To ensure the correct time range for running the performance test is displayed in the online graph, verify the time zone is synchronized on the Performance Center Server, ALM, and any external analysis database servers.
Send Us Feedback

Let us know how we can improve your experience with the Installation Guide. Send your email to: docteam@microfocus.com